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Getting Started  
Welcome 
GoToMeeting was designed to make it easier for everyone to organize and participate in online meetings, 
so you can do more and travel less. 

GoToMeeting users can collaborate on documents, deliver presentations, perform product 
demonstrations and securely share confidential information from anywhere, at any time. GoToMeeting’s 
rapid download, quick meeting setup and intuitive user interface has meeting organizers and attendees 
up and running in a matter of seconds. 

GoToMeeting incorporates industry-standard security features and end-to-end SSL encryption to ensure 
that login information and meeting data are secure. This high level of security allows GoToMeeting users 
to confidently present and collaborate on any data. Users can rest assured that information such as sales 
forecasts, financial data and M&A contracts will not be viewable to anyone except meeting participants. 

GoToMeeting’s All You Can Meet® pricing model provides easy-to-understand billing that helps you 
effectively budget and manage online meeting costs with no unexpected overage charges or additional 
fees. Meet as often and as long as you want for one low flat fee. 

To further increase your savings, GoToMeeting now offers an extended choice of integrated audio 
conferencing services for your online meetings at no additional cost. With GoToMeeting integrated audio, 
you can choose between phone conferencing and Voice over Internet Protocol (VoIP) or allow both 
options. 
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Using This Guide 

Guide Structure 
This guide is divided into nine sections: 

• Getting Started – This section provides information on system requirements, useful terms and a 
product feature summary. 

• Install GoToMeeting – The section covers information on creating an organizer account, installing 
GoToMeeting, managing your GoToMeeting Preferences, and GoToMeeting integration. 

• Organize Meetings – This section is for GoToMeeting organizers and covers how to schedule, 
view, edit and cancel meetings. 

• GoToMeeting Integrated Audio – This section covers phone conferencing, VoIP, hardware setup 
recommendations and audio best practices. 

• Start Meetings – This section covers the multiple ways an organizer can begin a meeting. 
• Presenter Controls – This section is for GoToMeeting presenters and covers features available 

during a meeting like attendee management, audio, chat and drawing tools. 
• Record Meetings – This section covers how to record, play back and distribute meetings. 
• Attend Meetings – This section is for any GoToMeeting attendee and covers how to join a 

meeting and how to use attendee features. 
• The GoToMeeting Web Site - This section is for GoToMeeting organizers and covers how to 

access and use the GoToMeeting Organizer Web site. 

Individual and Corporate Plan Users 
This user  guide addresses both individual GoToMeeting users and GoToMeeting Corporate users. While 
most features apply to both audiences, some content relates to just one audience. To help you identify 
when something is just for one specific audience, this guide will clearly note the audience for any user-
specific content. 

Feature Notes 

• Individual GoToMeeting organizers may invite up to 15 meeting attendees, for a total of 16 people 
in each meeting. 

• GoToMeeting Corporate organizers may invite up to 25 meeting attendees, for a total of 26 people 
in each meeting.  

Mac Users 

GoToMeeting users can host and attend meetings on both PCs and Mac® computers. Significant 
differences in how GoToMeeting works on the Mac platform are highlighted with this icon.   
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System Requirements 
For PC-Based Organizers and Attendees 

• Required: Windows® 7, Vista, XP, 2003 Server or 2000 (Linux is not supported)  
• Required: Internet Explorer® 6.0 or newer, or Mozilla® Firefox® 3.0 or newer (JavaScript™ and 

Java™ enabled) . If needed, download Java here. 
• Internet Connection Required: Cable modem, DSL or better recommended 
• Recommended: Minimum of Pentium® class 1GHz CPU with 512 MB of RAM (2 GB of RAM for 

Windows Vista) 

For Mac-Based Organizers and Attendees 

• Required: Mac OS® X 10.4.11 (Tiger®), OS X 10.5 (Leopard®), OS X 10.6 (Snow Leopard®) 
• Required: Safari™ 3.0 or newer, or Firefox 3.0 or newer; (JavaScript and Java enabled)  
• Internet Connection Required: Cable modem, DSL or better recommended 
• Required: PowerPC G4/G5 or Intel processor, 512 MB of RAM or better recommended 

To Use VoIP 

• Required: Fast Internet connection  (384 kbps or more recommended) 
• Required: Headset (USB recommended) or microphone and speakers 

For Meeting Recording 

• Required: Windows Media® Player Version 9 or newer  
• Required: Minimum Super VGA (800x600) or better  
• Required: Fast Internet connection(384 kbps or more recommended) 
• Required: Sound card  
• Required: Telephone attachment device (if not using GoToMeeting integrated audio) 
• Recommended: 1 GB of hard disk space  
• Recommended: 1024 x 768 or higher screen resolution  
• Recommended: Minimum Pentium 800 MHz with 1 GB of RAM for transcoding to Windows Media 

Player file format 

Recording a meeting is only available using a PC. 

  

Integrations 

• Microsoft® Office® Integration: Microsoft Office 2002 or later 
• Outlook Integration: Microsoft Outlook® 2000 or later 
• Lotus Notes® Integration: IBM® Lotus Notes Version 7.0 or later 
• Instant-Messaging Integration: GoToMeeting integrates with the most widely used instant-

messaging applications including: Yahoo!® Messenger™, Windows Live™ Messenger, Skype™ 
Chat, Microsoft® Communicator and Google Talk™ 

Note: Instant-Messaging Integration options are only available for use by GoToMeeting organizers 

  

  

http://www.java.com/en/download/inc/windows_upgrade_ie.jsp�
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Terms 
• Organizer – An organizer has a GoToMeeting account that enables him or her to schedule 

and host meetings. The organizer can also grant and revoke attendee privileges, such as, 
passing the presenter role, sharing keyboard and mouse, inviting attendees and dismissing 
others. 

• Attendee – An attendee is any person who attends a meeting, including organizers and 
presenters. By default, attendees can view the presenter's screen. An attendee may remotely 
control the presenter's computer screen if given the privilege. An attendee may optionally chat with 
other attendees, use Drawing Tools or view the Attendee List. 

• Presenter – A presenter is any attendee who is giving a presentation and shares his or her 
computer screen with all the attendees. The initial presenter is also the initial meeting organizer. 
The presenter also determines who gets to control the keyboard and mouse of the remotely 
viewed screen. 

• GoToMeeting Web Site – The Web site located at www.gotomeeting.com is where organizers 
manage their accounts and host meetings and also where attendees join meetings. 

• GoToMeeting System Tray Icon – The system tray icon is used by PC users to access organizer 
features of GoToMeeting and to provide status of GoToMeeting service. To access organizer 
features, right-click the system tray icon and select the desired feature. 

 

• GoToMeeting Suite Icon – The GoToMeeting Suite icon is used by Mac users to access 
organizer features. To access organizer features, double-click the GoToMeeting Suite icon on your 
desktop. 

• Account Password – An account password is what organizers use to log in to the GoToMeeting 
Web site. It must contain at least eight characters and include both letters and numbers. 

• Meeting Password – A meeting password is an optional value chosen by the meeting organizer 
that is used to help authenticate attendees.  Requiring and specifying a meeting password 
provides enhanced privacy guarantees for the meeting by ensuring that only attendees that know 
the meeting password may join the meeting.  The meeting password is never transmitted to Citrix 
Online in any form.  The meeting password may be any alphanumeric string of one character or 
more the organizer would like such as: “7891,” “Happy Birthday,” “Citrix123,” etc.   Picking a 
meeting password that is difficult to guess helps to maximize security. 

• Viewer – The Viewer is the window displayed on the attendees’ computers in which the 
presenter’s PC desktop or shared application appears. The Viewer window has its own title and 
menu bars. 

• Presenter’s PC Image – The presenter’s PC image is the picture of the presenter’s PC desktop or 
shared application that appears to attendees in the Viewer window. 

• Published Application – An application that is pushed to a client PC by Citrix Presentation 
Server. 

https://www1.gotomeeting.com/�
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Product Features 

Intuitive User Interface Easy-to-understand controls enable you to start and join meetings in seconds 
without training. 

Specific Application 
Sharing* 

PC-based presenters can select one application to display, so they don’t 
have to share their entire desktops, or worry about receiving distracting pop-
ups from instant messages or email. 

Screen Clean* PC-based presenters can click this option to instantly hide icons, wallpaper 
background and toolbars on their desktops, so attendees won’t be distracted 
by them. 

GoToMeeting Integrated 
Audio 

Integrated audio service that allows you to choose between phone 
conferencing and Voice over Internet Protocol (VoIP) options for you and 
your attendees; or you can allow both options to be used in the same 
meeting. 

Mac Support Organize, present at and attend meetings from a Mac. 

Share Keyboard and 
Mouse Control 

Securely collaborate on documents in real time. 

Instantly Change 
Presenters 

Enable any participant to present to the entire group. 

Desktop Recording and 
Meeting Playback* 

Allows PC-based presenters to record and play back meeting sessions to 
review meetings or send copies to absent colleagues or customers. 

Chat Window Chat online with any participant in the meeting. 

Drawing Tools – Pen, 
Highlighter, Arrow, 
Spotlight 

Gives attendees the ability to draw, highlight and point to items of interest 
right on the screen. Presenters have additional ability to use the spotlight and 
can erase all markings on the screen. 

Multiple Monitor 
Support 

Integrates GoToMeeting with multiple monitor systems, so users can use one 
for screen sharing and the other for different tasks, or share all of their 
screens. 

Transparent Control 
Panel 

Allows PC-based presenters to keep their Control Panel open on their screen 
while screen sharing and chatting. 

Inactivity Time-Out Provides added security for PC users by automatically stopping screen 
sharing after a specified period of inactivity (i.e., no keyboard or mouse 
movement). Default is 30 minutes, but setting is configurable up to one hour. 

Integration* Easily start or join GoToMeeting sessions through various email and instant-
messaging applications. 

Attendee Authority Grant and revoke attendee privileges before or during a meeting session. 

Reporting Get detailed reports for trend analysis and ROI validation. 

True 24-Bit Color Share presentations, graphics, pictures and applications with all meeting 
attendees in true 24-bit color. 

Features marked with an asterisk (*) are not currently available for Mac users. 
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Install GoToMeeting 
Before they can schedule or start a meeting, first-time organizers need to create their GoToMeeting 
accounts and download the GoToMeeting software. It generally takes less than 2 minutes to set up a 
GoToMeeting account. 

Create Your Organizer Account - Individual Organizers 
Personal plan users will sign themselves up for service. 

 To create your account 

1. Go to www.gotomeeting.com and click the Try It Free button. 
2. On the Create Your Account page, enter your information and click Continue. 
3. Enter your password and click Continue. 
4. If required, enter credit card and billing information and click Get Free Trial. 
5. On the GoToMeeting Software page, click the Install Our Software button. 
6. If prompted, click Yes, Grant (or Trust on a Mac) to accept the download. 

Create Your Organizer Account - Corporate Plan Users 
If you are a GoToMeeting Corporate user you will be invited to join by your company’s GoToMeeting 
Administrator. Before being able to schedule or start a meeting you need to create your GoToMeeting 
account and download the GoToMeeting software. 

 To create your Corporate Plan organizer account 

1. Go to your email application and open the GoToMeeting invitation email you received from your 
administrator entitled GoToMeeting Account Confirmation. 

2. In the email, click the activation link to create your organizer account. 
3. On the Create Account page, enter your information and click Create Account. 
4. On the Download GoToMeeting page, click the Download button. 
5. If prompted, click Yes, Grant or Trust to accept the download. 

https://www1.gotomeeting.com/�
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Install GoToMeeting 
Installing GoToMeeting is as simple as hosting your first practice meeting from www.gotomeeting.com. 
You are welcome to install GoToMeeting on as many of your computers as you like but keep in mind you 
can only host a meeting from one computer at a time.  

 To install the GoToMeeting application 

1. Go to www.gotomeeting.com  and click the Host a Meeting button. 
2. Type your Email and GoToMeeting password from the Login screen and click Log In. 
3. Select either Meet Now to host your first meeting or click Schedule Meeting. Either way 

GoToMeeting will automatically be installed on your computer. 

 

4. Congratulations - the GoToMeeting application is installed on your computer! For PC users, the 
GoToMeeting icon appears in your system tray and is ready for use.  

 

For Mac users, the GoToMeeting Suite icon appears on your desktop. Once downloaded, 
GoToMeeting can be moved from your desktop to a location of your choice, including your dock. 

 

https://www.gotomeeting.com/�
https://www1.gotomeeting.com/�
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The GoToMeeting Application 
To access GoToMeeting functions directly from your PC desktop, 
simply right-click the  icon in your system tray and select the 
desired function.  

• Meet Now: Enables organizers to immediately start 
impromptu meetings without needing to enter meeting 
information  

• Schedule a Meeting: Enables organizers to schedule 
meetings 

• My Meetings: Provides organizers access to their scheduled 
meetings and the ability to add, edit or delete scheduled 
meetings  

• Join: Enables organizers to join meetings already in progress 
• Help: Launches online help  
• Preferences: Provides access to user preferences  
• About: Provides GoToMeeting software version information  
• Exit: Closes the GoToMeeting application  

Note: If your account includes GoToWebinar, additional menu options will appear. 

Mac users can access many GoToMeeting functions by double-clicking the GoToMeeting icon on 
their desktop or clicking the icon in their dock. Other functions, including Help and Preferences, 

can be accessed from the GoToMeeting menu bar.  
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Preferences for PC Users 
The GoToMeeting Preferences feature allows organizers to set preferences for running GoToMeeting, 
choose which GoToMeeting integrations are displayed and test the GoToMeeting connection. 

PC users can access GoToMeeting Preferences by right-clicking the  icon in the system tray, or if in a 
meeting, from the file menu. 

Note: Preference options outlined in this guide are specific to GoToMeeting. If your account includes GoToWebinar, additional 
preference options will appear. For more information on GoToWebinar preference options, please refer to the Getting Started 
section of the GoToWebinar help. 

  

Mac users may access their GoToMeeting Preferences by double-clicking the GoToMeeting Suite 
icon on their desktop and selecting Preferences from the GoToMeeting menu in the menu bar. 
Please see Preferences - Mac Users for more information. 

  



GoToMeeting® User Guide

© 2010 Citrix Online, LLC. All rights reserved. 10

Start Up Preferences 
 
The Start Up category lets you 
determine how you start 
GoToMeeting.  

• Automatically after I log in to 
Windows – This option starts 
GoToMeeting automatically 
after you log in to your PC. 

• Manually – This option sets 
GoToMeeting to start only 
when you launch the 
application from your Programs 
Menu. 

• Remember me on this 
computer – This checkbox 
enables automatic log in to 
GoToMeeting.  

• Show me desktop notifications 
– Desktop Notifications is a 
free GoToMeeting feature 
designed to deliver simple and 
effortless access to 
complimentary Citrix Online 
software upgrades, 
information, news and discounts individual users may be eligible for. 

• Remind me of upcoming meetings – This checkbox becomes available if you select Remember me 
on this computer and provides reminders for your scheduled meetings. 

• Periodically synchronize reminders with My Meetings – This option is applicable to Citrix 
Presentation Server users and is the recommended setting for optimal use. This checkbox 
becomes available if you select the Remind me of upcoming meetings checkbox and will 
synchronize meetings scheduled from a published Outlook® or Lotus Notes® with a local 
installation of GoToMeeting. 
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General Preferences 
The General category lets you set your 
general GoToMeeting preferences. 

• File save settings – Enables you 
to save the Chat Log to any drive 
or directory. 

• Security – Set the inactivity time-
out to automatically stop screen 
sharing if there is no keyboard 
input or mouse movement for the 
specified period of time. 

• Session Identity – Remember 
your name and email as 
displayed in the attendee list.  

• Desktop notifications – This 
option enables/disables various 
system messages to appear to 
an organizer when specific 
meeting actions occur. 
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Meetings Preferences 
 
The Meetings category lets 
you determine which 
GoToMeeting options are 
available to attendees during a 
meeting. You can also select 
which messages are viewable 
during a meeting.  

• Enable or disable the 
ability for attendees to 
chat and view the 
Attendee List.  

• Create a Chat Welcome 
Message that is sent to 
each attendee upon 
joining the meeting.  

• Enable or disable 
various system 
messages that appear 
to you when specific 
meeting actions occur. 

• Select the desired color 
for your GoToMeeting 
Viewer and Control 
Panel. 

Note: If you disable the chat bubble 
option, a new message icon will still appear on the Grab Tab to notify you of new chat messages as they are received.  
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Recording Preferences 
The Recording category lets you 
set your audio and video 
recording preferences.  

• Audio - Allows you to 
enable or disable 
recording the audio 
portion of your meeting. 
To record, choose which 
audio service you have 
scheduled to use for your 
meeting (see tables 
below). 

• Video - Allows you to 
select the meeting 
recording output format 
and destination for saving 
the file. 

Note: Be sure to check your audio device 
settings under Audio in the left menu.  

Note: Mac users can only view meetings 
recorded in the Windows Media Player 
format. 

• Save in - Select the folder 
in which you want to save 
your recording. 

  

  

  

  

  

  

Using GoToMeeting Integrated Audio Using Your Own Audio Service 

Records all unmuted speakers in the meeting. To record all unmuted speakers, you will need a phone patch 
connected to both your phone and the “mic in” port of your PC.  

To record just your voice, you will need a microphone connected 
to your PC.  

If you want to use VoIP with your own audio service, please 
contact your Account Manager (GoToMeeting Corporate plans) or 
Global Customer Support (GoToMeeting plans).  

Your PC must have a sound card installed in order to record audio. For example, if you can hear music through your 
PC, you have a sound card. 
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Mac users are not able to record a meeting. If you want your meeting recorded, promote a PC 

attendee to organizer in-session. A PC-based organizer will have the recording feature. 

Integration Preferences 
The Integrations category lets you 
determine where to display GoToMeeting 
integrations. Options include: 

• Use GoToMeeting with – Select 
your GoToMeeting email and 
calendar integration. By selecting 
My default email application you 
can integrate with MAPI-compliant 
email/calendar programs other than 
Microsoft Outlook and Lotus Notes. 
Depending on your email 
application's capabilities, 
integration with MAPI-enabled 
programs allows for features such 
as automatically adding meetings to 
a calendar and automatic creation 
of email messages with meeting 
information.  

• Show button in messenger 
applications – Display the 
GoToMeeting Quick Launch button in your selected instant-messaging applications.  

Note: Changes will only be displayed after restarting Outlook, Lotus Notes and/or the instant -messaging application. 

  

Note: Citrix Presentation Server users may have their Integrations settings automatically configured by their Presentation Server 
Administrators so that GoToMeeting integrates with published email and calendaring software. In order to integrate with published 
email and calendaring software, the Integrations setting should have no check mark in the “Use GoToMeeting with” box and all 
meetings should be scheduled from the published Outlook/Lotus Notes Toolbar. This is also the recommended setting if your are 
prompted to disable local email client integration. 
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Connection Preferences 
The Connection category allows you to test the status of your GoToMeeting connection. 

Note: To ensure a valid connection test, we advise that you refrain from testing your connection unless a GoToMeeting Global 
Customer Care representative directs you to perform the connection test. 

 
 

Audio Preferences 
The Audio category lets you set up and test your 
microphone and speakers for recording and for your 
meetings utilizing VoIP. If changes to your audio 
settings are made during a meeting, your microphone 
is temporarily muted so you can privately manage your 
settings.  

• Microphone Setup – Select a microphone from 
the drop-down menu. To test, speak into your 
microphone; if connected correctly, the sound 
bar will move when you speak. 

• Speakers Setup – Select your speakers from 
the drop-down menu. To test, click Play Sound; 
if connected correctly, the sound bar will move 
and you will hear a short soundtrack. 

• Advanced - GoToMeeting automatically adjusts 
system mixer settings. We recommend you 
keep this checked. If you uncheck this selection, 
you must manually configure your audio settings 
through Windows Sounds and Audio Devices. 

• Use automatic volume and noise processing - This option usually improves audio quality when 
people are talking. Unchecking this box may improve quality of music or other audio sources.  

  



GoToMeeting® User Guide

© 2010 Citrix Online, LLC. All rights reserved. 16

Preferences for Mac Users 
GoToMeeting Preferences allow organizers to set preferences for running GoToMeeting, choose which 
GoToMeeting integrations are displayed and test the GoToMeeting connection.  

Mac users may access GoToMeeting preferences by double-clicking the GoToMeeting Suite icon on their 
desktop and selecting Preferences from the GoToMeeting menu in the menu bar.  

Note: Preference options outlined in this guide are specific to GoToMeeting. If your account includes GoToWebinar, additional 
preference options will appear. For more information on GoToWebinar preference options, please refer to the Getting Started 
section of the GoToWebinar help file. 

 

Start Up Preferences 

The Start Up tab lets you determine whether GoToMeeting is available immediately after startup.   

• Remember me on this computer – This checkbox enables automatic log in to GoToMeeting.  

General Preferences  

The General tab lets you set your general GoToMeeting preferences. 

• Session Identity – Remember your name and email as displayed in the attendee list. 

Meeting Preferences 

The Meetings tab lets you determine which GoToMeeting options are available to attendees during a 
meeting. You can also select which messages are viewable during a meeting. Options include: 

• Enable or disable the ability for attendees to chat and view the Attendee List.  
• Create a Chat Welcome Message that is sent to each attendee upon joining the meeting. 

Integrations Preferences  

The Integrations tab lets you determine where to display GoToMeeting integrations. 

By selecting My default email application you can integrate with MAPI-compliant email/calendar programs 
other than Microsoft Outlook and Lotus Notes. Depending on your email application's capabilities, 
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integration with MAPI-enabled programs allows for features such as automatically adding meetings to a 
calendar and automatic creation of email messages with meeting information 

Connection Preferences 

The Connection tab allows you to test the status of your GoToMeeting connection. 

Note: To ensure a valid connection test, we advise that you refrain from testing your connection unless a GoToMeeting Global 
Customer Care representative directs you to perform the connection test. 
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GoToMeeting Outlook Toolbar 
The GoToMeeting Outlook Toolbar provides PC-
based users quick and easy access to 
GoToMeeting functions right from Microsoft 
Outlook. It includes the Meet Now and Schedule 
Meeting buttons, in addition to links to Host a 
Meeting and Join a Meeting and access to the My 
Meetings, Help and About pages. 

The GoToMeeting Outlook bar can be added or 
removed from the Preferences menu. 

  

Integration with Microsoft Outlook is currently unavailable on the Mac. 

  

 To add the Outlook Toolbar 

1. Right-click the   icon in the system tray and select Preferences. 
2. On the Integrations tab select Outlook and any other applications you would like integrated with 

GoToMeeting. 
3. Click Ok. 

 
Outlook may need to be shut down and restarted for the GoToMeeting Outlook bar to appear. 

 
Note: Outlook integration requires Microsoft Outlook 2002 or later. Organizers using the Outlook published by Citrix Presentation 
Server may need to manually add the Outlook toolbar from the Outlook tools menu. For more details, see the Set Up GoToMeeting 
for Use with Citrix Presentation Server section of this guide. 
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GoToMeeting Lotus Notes Menu Options 
The GoToMeeting Lotus Notes menu options provide quick and easy access to GoToMeeting functions 
right from the IBM Lotus Notes interface. It includes the Meet Now and Schedule Meeting buttons, in 
addition to access to your My Meetings dialog box. 

 
Note: Lotus Notes integration requires IBM Lotus Notes 7.0 or newer. Lotus Notes may need to be shut down and restarted for the 
GoToMeeting menu options to appear. The GoToMeeting Lotus Notes menu options can be added or removed from the 
GoToMeeting Preferences menu. Organizers using Citrix Presentation Server should contact their Presentation Server 
Administrator to display or remove the GoToMeeting Lotus Notes menu options in their published IBM Lotus Notes. 
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GoToMeeting Messenger Button 
The GoToMeeting Messenger button provides convenient access to starting an impromptu meeting right 
from the Messenger application.  

Note: Please see the Software Requirements section to check what instant-messaging products and versions are supported. 
Instant-messaging applications may need to be shut down and restarted for the GoToMeeting Messenger button to appear. The 
GoToMeeting Messenger button can be added or removed from the Preferences Integrations category. 

 



GoToMeeting® User Guide

© 2010 Citrix Online, LLC. All rights reserved. 21

Set Up GoToMeeting for Use with Citrix Presentation Server 
Preferences 

Depending on your Presentation Server environment, your Presentation Server administrator can choose 
to configure your GoToMeeting settings for you without notifying you; configure your settings and notify 
you of those settings; or allow you to configure them yourself. If your administrator has chosen your 
configurations for you, you won’t need to do anything; if your administrator has configured your settings 
and opted to notify you, you will see a notification dialog when you start your first meeting from your 
published environment. 

 

If your Citrix Presentation Server administrator has not already configured your GoToMeeting 
preferences, the recommended settings can be configured under the StartUp tab and the Integrations 
tab in the Preferences dialog. 

  

Recommended settings for the Start Up category: 

• Enable “Remind me of upcoming meetings” – This checkbox becomes available if you select 
"Automatically log in to GoToMeeting” and will provide you with reminders for your scheduled 
meetings. 

• Enable “Periodically synchronize reminders with My Meetings” - This preference option is 
applicable to users of Citrix Presentation Server and is the recommended setting for optimal use. 
This checkbox becomes available if you select the ““Remind me of upcoming meetings” checkbox 
and will synchronize meetings scheduled from a published Outlook® or Lotus Notes® with a local 
installation of GoToMeeting. 
  

Recommended settings for the Integrations tab: 

1. Select your desired integration from the list of GoToMeeting integrations 
2. Click the Advanced button and confirm that the Application listed in the Application Name field is 

the same as your selection from the GoToMeeting Integrations list. 
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 To configure GoToMeeting preferences 

1. Right-click the GoToMeeting system tray icon and select Preferences. 
2. Select the appropriate category for the set of preferences you want to customize. 
3. Select your preferences. 
4. Click OK. 

 Or 
1. When in a meeting, select Preferences from the Tools menu in the Control Panel. 
2. Select the appropriate category for the set of preferences you want to customize. 
3. Select your preferences. 
4. Click OK. 

Displaying the GoToMeeting Toolbar in Published Outlook 

Organizers using Outlook published by Citrix Presentation Server may need to activate the Outlook 
toolbar manually in order for it to display the first time.  

 To activate the Outlook toolbar if it does not automatically display 

1. Open Outlook. 
2. Select Customize from the Tools menu. 
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3. Click to check the box next to GoToMeeting. 

 

4. The Outlook toolbar will appear in your published Outlook on the Citrix Presentation Server. 

 
Note: You may need to restart Outlook for the toolbar to appear. 

  

Removing the Outlook Toolbar in Published Outlook 

 To remove the Outlook toolbar  

1. Open Outlook. 
2. Select Customize from the Tools menu. 
3. Deselect GoToMeeting from the list of toolbars. 

For more information about using GoToMeeting with Presentation Server, refer to GoToMeeting for Citrix 
Presentation Server FAQs. 
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Organize Meetings 
Organizer Role Overview 
With a GoToMeeting account, an organizer can schedule and host meetings, grant and revoke attendee 
privileges like passing the presenter role and invite/dismiss attendees. 

• Organizers need to first create their accounts and download the GoToMeeting software on their 
computers before they can schedule or conduct meetings.  

• Organizer must be present at the start of any meeting as the meeting host. 
• Organizers are responsible for creating scheduled meetings or starting impromptu meetings.  
• Organizers invite attendees and may do so via phone, email or instant message. 
• GoToMeeting meetings can be started from the  icon in the PC system tray, the Mac 

GoToMeeting Suite icon, the GoToMeeting Web site, the GoToMeeting Outlook bar or the 
GoToMeeting Messenger button. 

• Once a meeting starts, the organizer becomes the meeting presenter. During the meeting, the 
organizer may pass the role of presenter to other attendees or promote an attendee to co-
organizer.\ 
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Schedule a Meeting 
As a GoToMeeting organizer you can quickly schedule meetings in advance or start an impromptu 
meeting directly from your desktop. Once scheduled, you can host as many meetings as you like with the 
existing meeting information no matter when it is scheduled. Keep in mind that a meeting will 
automatically expire midnight following the scheduled meeting time. If you wish to save that meeting 
information for future meetings then select the Recurring meeting option. 

 To schedule a meeting 

1. Right-click the   icon in the system tray 
on a PC or double-click the GoToMeeting 
Suite icon on a Mac and select Schedule 
a Meeting. 

2. If prompted, enter your Email and 
Password and click Log In.  

3. On the Schedule Meeting  window, enter: 
• Subject – Enter the title of your 

meeting. 
• When will this meeting take place? 

– Select the date and start time. 
• Recurring meeting – Check this 

box to reuse the same meeting 
information for future meetings. 

• Audio – Select the GoToMeeting 
integrated audio or use your own.  

• Provide VoIP only (requires 
microphone and speakers) - All 
attendees join the audio portion via 
the Internet with built-in VoIP 
(Voice over Internet Protocol). 

• Provide a conference call number 
only - All attendees join the audio 
portion through the telephone. 

• Provide both - Allows all attendees 
to join the audio portion through 
the telephone or VoIP. Attendees 
joining through VoIP must have 
speakers to hear the meeting and 
a microphone if you would like them to speak. Attendees can switch between these audio 
options during a meeting. 

Note: If you are using the GoToMeeting Integrated Audio, you can provide toll numbers for multiple countries. Please see 
Schedule an International Meeting for more information. 

• Provide your own conference call information – Select this option if you wish to use your 
company’s existing conference phone number. 

• Meeting password - If you wish to protect your meeting with a password you will be 
prompted for it when you start your meeting and/or invite additional attendees. Your 
attendees will also need to know this password to join. 

4. Click the Schedule button when complete. 
 
You will receive notification that your meeting has been scheduled. If you have chosen to integrate 
with Lotus Notes or Microsoft Outlook, a meeting reminder will be generated and give you the 
option of inviting attendees via an Calendar appointment. 

  



GoToMeeting® User Guide

© 2010 Citrix Online, LLC. All rights reserved. 26

 To view your scheduled meeting 

• Right-click the   icon in the system tray on a PC or double-click the GoToMeeting Suite icon on 
a Mac and select My Meetings. 

-Or- 

• You can also view your scheduled meeting online from the My Meetings screen until midnight 
following the scheduled meeting time. 

Schedule Recurring Meetings 
With the recurring meeting feature your meeting ID, phone number, access code and any other settings 
are preserved indefinitely for your future recurring meetings. This feature can be a time saver if you have 
routine meetings or want to post the information on a Web site. Please see Schedule a Meeting for more 
information. 

 There are a few important considerations to keep in mind when creating recurring meetings: 

• The recurring meeting will only appear once in the My Meetings window and the Organizer Web 
site and will be labeled “Recurring.” You will need to use your own local calendar applications to 
schedule and track recurring meetings. 

• The Meeting URL/ID and conference number stays available indefinitely. 
• Scheduled meetings that aren't marked as Recurring will expire at midnight following the 

scheduled meeting time. 
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Schedule International Meetings 
As a GoToMeeting organizer you can offer your international attendees conference numbers specific to 
the country they are calling from. For example, if your attendees join from three different countries then 
you can provide three different international numbers that all access the same meeting. By doing this you 
and your attendees can avoid international rates and the trouble of looking up and dialing International 
Country Codes. To manage your default country preferences please see Audio Conference Options. 

Note: The GoToMeeting conference call service includes the following international coverage: Australia, Austria, Belgium, Denmark, 
France, Germany, Ireland, Italy, Netherlands, New Zealand, Norway, Spain, Sweden, Switzerland and United Kingdom.   

 To schedule a meeting with international conference numbers 

1. From the Schedule a Meeting window select GoToMeeting conference call service and then the 
Edit countries link. 

2. From the Edit Countries window select as many countries as necessary and click Done. 
3. Click Schedule to confirm the new meeting. 
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View Scheduled Meetings 
Organizers can view all scheduled meetings via the GoToMeeting application. 

 To view scheduled meetings via the GoToMeeting application 

1. Right-click the  icon in the PC system tray or double-click the GoToMeeting Suite icon on 
a Mac and select My Meetings. 

2. Enter your Email and Password in the Login window, and click Log In.  

The My Meetings window appears listing all scheduled meetings. 

 
Note: Scheduled meetings may al so be viewed from the www.gotomeeting.com Web site after logging in to your account. 

https://www1.gotomeeting.com/�
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Invite Attendees to a Scheduled Meeting 
An organizer can invite attendees to a scheduled meeting at any time prior to the start of the meeting.  

Note: For information on how to invite attendees to a meeting already in progress, please see the Invite Attendees During a Meeting 
section. 

 To invite attendees to a scheduled meeting 

1. Right-click the  icon in the PC system tray or double-click the GoToMeeting Suite icon on a Mac 
and select My Meetings. 

2. Enter your Email and Password in the Login window, and click Log In.  
3. On the My Meetings window, select the meeting you want to invite attendees to by clicking the 

name of the meeting in the Subject column, and click the Invite button. 
a. If you have an integrated email application an email will automatically be generated with the 

meeting information included in the body text: Simply send the email to attendees. 
b. If you do not have an integrated email application, the Meeting Scheduled window will 

appear: Simply click the Show invitation text link to display the invitation information and 
on the Invitation Text – GoToMeeting dialog box click the Copy to Clipboard button and 
paste the invitation information into your email program or convey the information to 
attendees via any desired method. 
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Edit a Scheduled Meeting 
Editing a scheduled meeting can be done at any time prior to the start of the meeting directly from your 
desktop. If you change the date and time you must remember to notify your attendees of that change. 
The easiest way to notify your attendees is to simply send out a new invitation. 

Note: Editing a scheduled meeting does not automatically update Microsoft Outlook or other calendar applications; neither will 
meeting attendees receive notice of the meeting change from GoToMeeting. Please be sure to contact meeting attendees directly 
with any changes to a scheduled meeting. 

 To edit a scheduled meeting 

1. Right-click the  icon in the PC system tray or double-click the GoToMeeting Suite icon on a Mac 
and select My Meetings. 

2. If prompted, enter your Email and Password in the Login window, and click Log In.  
3. Select the meeting you want to modify and then click the Edit button. 
4. Make any changes and click Save. 

 

4. Be sure to contact any previously invited attendees to notify them of the change! 
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Cancel a Scheduled Meeting 
As a GoToMeeting organizer you can easily delete a scheduled meeting at any time prior to the start of 
the meeting directly from your desktop.  

Note: Canceling a scheduled meeting will not be automatically updated in Microsoft Outlook or other calendar applications; neither 
will meeting attendees receive notice of the cancellation from GoToMeeting. Please be sure to contact meeting attendees directly to 
notify them of the cancellation. 

 To cancel a scheduled meeting 

1. Right-click the  icon in the PC system tray or double-click the GoToMeeting Suite icon on a Mac 
and select My Meetings. 

2. If prompted, enter your Email and Password and click Log In.  
3. Select the meeting you want to cancel and click Delete. 

 

4. Click Ok to confirm deletion of meeting. 
5. Be sure to notify any previously invited attendees about the cancellation! 
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GoToMeeting Integrated Audio 
GoToMeeting includes an integrated audio solution at no extra cost to you. Choose between phone and 
Voice over Internet Protocol (VoIP) or allow both options. Participants who join the meeting via telephone 
dial a toll-based number that GoToMeeting provides automatically. Participants are then charged their 
standard long-distance rate for calling this toll-based number, just as if they made a regular long-distance 
call. Participants who join the meeting via VoIP need speakers or headphones to hear the GoToMeeting 
session and a microphone if you want them to speak. (We recommend a USB headset). 

Audio details can be found in the Control Panel once the meeting starts. GoToMeeting will automatically 
generate a conference call number, access code and Audio PIN for all attendees joining via telephone. 

You may decide to use the GoToMeeting integrated audio or choose another method of bringing audio to 
your online meetings  

Note: If you choose to use your own audio service provider for the audio portion of the meeting, GoToMeeting will include your dial-
in numbers with the meeting information; however GoToMeeting audio features (such as VoIP and Control Panel audio 
management) do not apply. 
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Audio Mode: Using Telephone 
At the specified meeting time, dial the conference call number. When prompted, enter the access code 
followed by the # key and then your unique Audio PIN. Once in a conference call, participants and 
organizers can enter commands using their phone keypads. 

Organizer Telephone Commands 
Command Feature Details 

*2 Count Provides the number of attendees dialed in to the conference. 

*3 Exit Exits the organizer from the conference call. 

*4 Menu Provides a menu of available conference commands. 

*5 Listening 
Modes 

Sets listening modes for the audience. Meeting organizers can 
cycle through three listening modes by pressing *5. 

• Mute:  organizers and panelists can unmute themselves 
by pressing *6 

• Mute: organizers and panelists cannot unmute 
themselves 

• Unmute: organizers and panelists are unmuted (default) 

*6 Mute/Unmute Mutes the organizer's line. Pressing *6 again will unmute the 
line. 

*8 Chime 
Controls 

Sets entry and exit chimes. By default, entry and exit chimes 
are on. Pressing *8 cycles through the following options. 

• Entry chime and exit chime on (default) 
•  Entry and exit chimes off 
• Entry chimes off exit chime on 
• Entry chime on exit chime off 

  

Attendees Telephone Commands 
Command Feature Details 

*3 Exit Exits the conference call. 
*4 Menu Provides a menu of available conference commands. 
*6 Mute/ Unmute Mutes the participant’s line. Pressing *6 again will unmute the line. 

  

Turning entry and exit chimes on/off 
You must be dialed in via telephone to turn entry and exit chimes on or off. In GoToMeeting entry and exit 
chimes are turned ON by default. Press *8 to cycle through the entry and exit chimes options. 
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Audio Mode: Using VoIP Checklist 
  

Mic & Speakers Device Recommendations 
When using Mic & Speakers, audio quality can vary based on your audio software/hardware 
manufacturer as well as your operating system. The following table lists tested hardware devices in order 
of best quality to poor quality.  

Listed in order from best quality to poor quality 

 

USB* headset connected to your 
computer 

Best 

 

Headphones and USB* microphone 
connected to your computer 

 

Analog** headset connected to your 
computer 

Good 

 

Headphones and analog 
microphone** connected to your 
computer  

+  

External speakers and analog 
microphone 

 

Laptop built-in microphone and 
speakers  

Poor 

 

External speakers and USB 
Webcam microphone  

Poor 

*USB Cable          **Analog Cable   
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Mic & Speakers Setup - PC Users 

To select and test your Mic & Speakers  

1. After you've logged into the session, select "Use 
Mic & Speakers" in the Audio pane of your 
Control Panel.  

2. Click Audio Setup.  
a. Select a microphone from the drop-down 

list (a). Speak into your microphone: If the 
correct device is selected, the meter will 
light up green. 

b. Select speakers from the drop-down 
menu (b). Click Play Sound: If connected correctly, the meter will light up green and you will 
hear an audio track through your speakers. 
Note: If the green meters do not light up, select another device listed in the menu and repeat the test. 

c. The volume bar can be adjusted at any time during the session (c).  
Note: Advanced - Audio levels are automatically adjusted. We recommend you keep this checked. If you uncheck 
this selection, you must manually configure your audio settings through Windows Sounds and Audio Devices. If 
your attendees can’t understand you because your voice is distorted, try un-checking “Microphone boost.” 

3. Click OK. 
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Audio Hardware Detection 
 If new audio hardware is plugged in during a session you will be prompted to use the device. If accepted, 
the application will automatically configure your audio preferences for the new hardware. 

 

Mic & Speakers Setup - Mac Users 
Mac users can select audio devices in-session only. Input and output devices connected to your 
computer are automatically detected. 

To select and test your Mic &Speakers 

1. You can select and test your audio devices through the Audio pane of the Control Panel. If your 
audio devices are connected correctly, you will see the sound meters in the control panel light up 
green. 

2. If the meters for Mic or Speakers do not light up green when you or others are speaking, click on 
the icons in the Audio pane of the Control Panel. A drop-down menu will appear when you click 
either icon.  
• Microphone - To test, speak into your microphone; if the correct device is selected, the meter 

will light up green. 
• Speakers - To test, select a device from the drop-down menu. If connected correctly, the meter 

will light up green and you will hear an audio track through your speakers.  
• If the green meters doe not light up, select another device listed in the menu and repeat the 

test. 
• Adjust speaker volume on your Mac keyboard. 
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3rd Party Audio and HiDef Conferencing 
When you schedule a meeting you 
can select which audio option works 
best for you and your attendees. If 
you choose to use a conferencing 
solution other than GoToMeeting 
integrated audio then all you have to 
do is include that information in the 
conference call field in the Schedule 
a Meeting dialog box.  

Once scheduled, you will see your 
3rd party conference number 
referenced in your meeting 
invitation, waiting room and the 
Audio pane in the presenter and 
attendee Control Panel. 

Note:  On-screen muting and VoIP audio are 
not available while using 3rd party audio 
solutions. 

You can obtain a toll-free or 
international access conference call 
number through most conference 
call vendors. Note that there is often 
an additional fee for these numbers. 

  

Citrix Online 
HiDef Conferencing™   

Citrix Online now offers additional 
audio solutions including toll-free 
numbers through HiDef 
Conferencing which can be used 
with GoToMeeting and 
GoToWebinar. If you already have a 
HiDef Conferencing account then simply include your phone number and meeting room ID in the 
conference call field in the Schedule a Meeting dialog box.  

If you wish to learn more about integrated toll-free audio service for GoToMeeting Corporate customers 
then please refer to  Integrated Toll-Free Audio for details. 

  

  

http://www.hidefconferencing.com/index.htm�
http://www.hidefconferencing.com/index.htm�
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Integrated Toll-Free Audio (GoToMeeting Corporate plans only) 
GoToMeeting Corporate organizers now have the option to host meetings and Webinars with any 
combination of toll-based, toll-free and VoIP audio. Features like on-screen muting and integrated 
recording remain the same regardless of which audio option is selected. 

Note: Integrated toll-free is not available to individual GoToMeeting users at this time.  

Integrated toll-free audio is a separate service and has to first be enabled by your company’s 
GoToMeeting account administrator. While there are no additional fees for toll-based and VoIP audio, 
additional per-minute charges are incurred for each attendee dialing in with the integrated toll-free audio 
service. At this time, the toll-free option is only available to callers within the United States. 

As with existing meetings and Webinars, each session will have a unique toll-free number and access 
code. If you wish to re-use the same audio options for your meetings, select the Recurring meeting box 
in the Schedule a meeting window. 

Note: For any Webinar, meeting or recurring meeting that was scheduled prior to an account’s toll-free integration, the regular toll 
based conference numbers will automatically be changed if toll-free numbers are added to an already existing meeting or Webinar. 
It is recommended that you resend the meeting invitation and Webinar confirmation emails to your participants so that they get 
access to the new numbers. The meeting ID and URL for those meetings and Webinars will not be impacted and the new 
conference number will be provided to the attendees in the waiting room as well as the Control Panel. 

  

Calculating Toll-Free Minutes 
Per-minute charges apply to all participants who dial in with the toll-free option. Those who join by regular 
toll numbers are charged rates based on their own long distance provider. There are no additional 
charges for those who join a meeting or Webinar with VoIP audio. 

To minimize billing, any attendee who joins a meeting or Webinar before the organizer starts the event is 
disconnected after 15 minutes of inactivity. If the meeting or Webinar is cancelled and never started by 
the organizer, then no charges are incurred. If, however, any organizer from the account joins the event, 
even if the meeting or Webinar is never actually started, the account is charged for the organizer’s 
minutes, along with the minutes incurred by any attendees waiting for the event to start. 

The organizer’s company will be billed separately for toll-free audio by Citrix Online Audio, LLC. 

  

http://support.gotomeeting.com/ics/support/default.asp?deptID=5641&task=knowledge&questionID=3742�
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Schedule a Meeting with Integrated Toll-Free Audio 

 To schedule a meeting with 
integrated toll-free audi 

1. Right-click the  icon in the 
system tray on a PC or double-
click the GoToMeeting Suite icon 
on a Mac and select Schedule a 
Meeting. 

2. Enter your email and password in 
the Login window, and click Log 
In. 

3. Schedule your meeting as you 
normally would by including the 
subject, date and time. 

4. To add a toll-free number to your 
meeting invitation, select the Edit 
Countries link, scroll to the 
bottom of the list and select the 
option for United States (toll-
free). 
 
The toll-free number can be 
offered to your attendees along 
with VoIP and the traditional toll-
conference option. 

5.   
Note: Additional per-minute charges are incurred for each attendee dialing in with the toll-free service. 
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Schedule a Meeting with Toll-Free and VoIP 
To offer your attendees a choice between two free audio options, simply ensure that the United States 
toll number has been deselected when you schedule the meeting. 
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Start a Meeting with Integrated Toll-Free Audio 
Starting a meeting with integrated toll-free audio is the same as starting any other meeting, but with one 
key difference. Because the organizer is charged for each attendee dialing in with toll-free audio, 
accounts enabled with integrated toll-free audio will no longer permit attendees to talk amongst 
themselves until the organizer officially launches GoToMeeting. If an organizer is late to start the meeting, 
attendees will remain on hold and will hear the following greeting: “The organizer has not yet started the 
meeting. You will be placed on hold until an organizer starts GoToMeeting.” 

  

Recording with Toll-Free Audio 
Whether you or your attendees join with VoIP, toll or toll-free audio, you can easily and seamlessly record 
all participants. From the Recording section of the Preferences window, simply select Use GoToMeeting 
Audio Service. For more information about the Recording feature, please refer to Recording a Meeting 
on the GoToMeeting support site. 
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Start/End a Scheduled Meeting 
Scheduled meetings are any GoToMeeting sessions that have been previously scheduled by the 
organizer in the GoToMeeting application.  

Scheduled GoToMeeting sessions can be started from the GoToMeeting PC system tray icon, the Mac 
GoToMeeting Suite icon, the GoToMeeting Web site and the GoToMeeting Outlook bar. 

Note: To start a meeting the GoToMeeting application must be installed on the PC or Mac being used by the meeting organizer. For 
more information on installing the GoToMeeting application please see the GoToMeeting Install GoToMeeting section. 

  

Start a Scheduled Meeting from Your Desktop 

 To start a scheduled meeting from your desktop 

1. Right-click the  icon in the PC system tray or double-click the GoToMeeting Suite icon on a Mac 
and select My Meetings. 

2. Enter your Email and Password in the Login window, and click Log In.  
3. On the My Meetings window, select the meeting you want to start by selecting the name in the 

Subject column and then click the Start button. 

Your meeting will start and the GoToMeeting Organizer Control Panel will appear on the right side 
of your desktop.  
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Start a Meeting from the Web 

  To start a scheduled meeting from the GoToMeeting Web site 

1. Log in to your organizer Web site. 
2. On the My Meetings page, locate the scheduled meeting you wish to start and click the Start 

Meeting button. 

 

3. If prompted, click Yes or Grant to accept the GoToMeeting download. 

Your meeting begins and the GoToMeeting Organizer Control Panel appears in the right side of 
your desktop. Please see the Organizer Control Panel section for more information. 

Start a Meeting from Outlook 

 To start a scheduled meeting from the GoToMeeting Outlook bar 

1. From the GoToMeeting toolbar in Outlook, 
click the GoToMeeting button and select My 
Meetings. 

2. On the Login window, enter your Email and 
Password and click Log In. 

3. On the My Meetings window, select the 
meeting you want to start by clicking the 
name of the meeting in the Subject column, 
and click the Start button. 

Your meeting begins and the GoToMeeting 
Organizer Control Panel appears in the right side of your desktop. Please see the Organizer 
Control Panel section for more information 

Note: If the GoToMeeting toolbar does not appear in your Microsoft Office application, see the GoToMeeting Application 
Preferences section for instructions. 
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Start a Meeting from IBM Lotus Notes 

 To start a scheduled meeting from the GoToMeeting IBM 
Lotus Notes Actions menu 

 
1. From the Actions menu in the Lotus Notes toolbar, select 

My GoToMeetings. 
2. On the Login window enter your Email address and 

Password and click Log In. 
3. On the My Meetings window, select the meeting you want 

to start by clicking the name in the Subject column, and 
click the Start button. 

Your meeting will start and the GoToMeeting Organizer 
Control Panel will appear on the right side of your desktop. 
Please see the Organizer Control Panel section for more 
information 

  

  

  

  

  

  

Start a Meeting from Microsoft Office 

  To start a scheduled meeting from 
the GoToMeeting Toolbar in Microsoft 
Office 

1. From the GoToMeeting toolbar in 
Microsoft Office, click the 
GoToMeeting button and select 
My Meetings. 

On the Login window, enter your 
Email address and Password and 
click Log In. 

2. On the My Meetings window, select the meeting you want to start by clicking the name in the 
Subject column, and click the Start button. 

3.  Your meeting will start and the GoToMeeting Organizer Control Panel will appear in the right side 
of your desktop. Please see the Organizer Control Panel section for more information 

Note: If the GoToMeeting toolbar does not appear in your Microsoft Office application, see the GoToMeeting Application 
Preferences section for instructions.  
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Start an Impromptu Meeting 
Start an Impromptu meeting at any time without having to schedule them in advance. The Meet Now 
feature is for last-minute or on-the-fly meetings that need to occur without prior notice. Impromptu 
meetings may be initiated either from the GoToMeeting PC system tray icon, the Mac GoToMeeting Suite 
icon, from the Microsoft Outlook tool bar, the Lotus Notes Actions menu or from an integrated instant-
messaging application.  

  

Start a Impromptu Meeting from your desktop 

 To start an impromptu meeting from your desktop 

1. Right-click the   icon in the PC system tray or double-click the GoToMeeting Suite icon on a 
Mac and select Meet Now. 

2. On the Login window, enter your Email address and Password and click Log In. 
3. Your meeting starts and the GoToMeeting Organizer Control Panel appears in the right side of 

your desktop. Conference call information appears in the meeting information pane of the 
Organizer Control Panel.  
 
 Or 

1. Double-click the  icon in the PC system tray.   
2. Your meeting starts and the GoToMeeting Organizer Control Panel appears on the right side of 

your desktop. Conference call information appears in the meeting information pane of the 
Organizer Control Panel.  

  

Start an impromptu meeting from the Web 

 To start an impromptu meeting from the GoToMeeting Web site 

1. Go to www.gotomeeting.com and click the Host a Meeting button. 
2. If prompted, click Yes or Grant to accept the GoToMeeting download. 
3. On the Login window, enter your Email address and Password and click Log In. 
4. On the Host a Meeting window, select Meet Now. 
5. Your meeting starts and the GoToMeeting Organizer Control Panel appears on the right side of 

your desktop. Conference call information appears in the meeting information pane of the 
Organizer Control Panel.  

   

Start an impromptu meeting from Outlook 

 To start an impromptu meeting from the GoToMeeting Toolbar in Outlook 

1. From the GoToMeeting Outlook bar, click the Meet Now button. 
2. On the Login window, enter your Email address and Password and click Log In. 
3. Your meeting will start and the GoToMeeting Organizer Control Panel will appear in the right side 

of your desktop. Audio information appears in the meeting information pane of the Organizer 
Control Panel.  

   

http://www.gotomeeting.com/�
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Start an Impromptu Meeting from Microsoft Office 

 To start an impromptu meeting from the GoToMeeting Toolbar in Microsoft Office 

1. From the GoToMeeting Toolbar in Microsoft Office, click the Meet now within button to launch an 
impromptu meeting. 

2. On the Login window, enter your Email address and Password and click Log In. 
3. Your meeting starts and the GoToMeeting Organizer Control Panel appears in the right side of 

your desktop. 
4. Click the Show My Screen button and your presentation starts in specific application-sharing 

mode. This means that GoToMeeting only displays the Microsoft Office window from which you 
started the impromptu meeting. 

Note: The GoToMeeting toolbar can be displayed in Microsoft Word, Excel and PowerPoint.  

   

Start an Impromptu Meeting from IBM Lotus Notes 

 To start an impromptu meeting from the IBM Lotus Notes Actions menu 

1. From the Lotus Notes menu options under the Actions menu, select Meet Now with 
GoToMeeting. 

2. On the Login window, enter your Email address and Password and click Log In. 
3. Your meeting will start and the GoToMeeting Organizer Control Panel will appear in the right side 

of your desktop. Audio information appears in the meeting information pane of the Organizer 
Control Panel 

   

Start an Impromptu Meeting from an Instant-Messaging Application 

 To start an impromptu meeting from an instant-messaging application 

1. Launch the instant-messaging application. 
2. Open a chat communication with the attendee you would like to meet. 
3. In the Title bar, click the GoToMeeting Messenger Button and select Meet Now. 
4. On the Login window, enter your Email address and Password and click Log In. 
5. Your meeting starts and the GoToMeeting Organizer Control Panel appears in the right side of 

your desktop. Audio information appears in the meeting information pane of the Organizer Control 
Panel.   
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Leave or End a Meeting 
Organizers may chose to either leave a meeting while allowing the meeting to continue, or to end a 
meeting completely. 

Note: If an organizer chooses to leave a meeting while allowing the meeting to continue he or she must first make another attendee 
an organizer for the meeting. 

 To leave a meeting and allow the meeting to continue 

1. From the File menu, select Leave Meeting. 
2. Click Choose an Organizer & Leave and then promote an attendee from the drop down list 

to attendee. 

 
Note: If you leave a meeting running that you started, you will not be allowed to host or join another meeting until the first meeting is 
finished.  

 To end a meeting 

1. From the File menu, select End Meeting. 
2. On the End meeting for everyone? confirmation dialog box, click Yes. 
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The Organizer/Presenter Control Panel 
When the organizer first joins the 
meeting the Presenter Control Panel 
appears on the right side of the 
desktop. The Presenter Control Panel 
gives organizers and presenters 
access to various organizer and 
presenter functions. The Presenter 
Control Panel is comprised of four 
panes: Screen Sharing, Attendee List, 
Audio, Chat and the Grab Tab. The 
Organizer Control Panel has a sixth 
pane, the Recording pane, which can 
be displayed by selecting View and 
then Recording from the Organizer 
Control Panel Menu Bar.  

Note: When the Organizer passes the Presenter 
role to another attendee, the Control Panel 
changes and the Screen Tools section is 
removed and given to the new presenter. 

• The Screen Sharing pane provides 
organizers/presenters with a visual 
reminder of On Air status, as well as the 
ability to show their screens, pause 
showing their screens, pass keyboard 
control and change presenters. (a) 

• The Grab Tab enables 
organizers/presenters to minimize the 
Control Panel to the side of their 
desktops to display their full desktops to 
attendees and still access Presenter 
Screen Tools. (b) 

• When selected from the View menu, the 
Recording pane gives 
organizers/presenters the ability to 
record meetings. (c) 

• The Attendee List pane provides 
organizers/presenters with a list of all 
meeting attendees and enables them to 
make other attendees organizers or 
presenters, grant or revoke attendee 
privileges and dismiss attendees. This 
pane also provides a handy way to 
invite more attendees. (d) 

• The Audio pane provides access to the 
audio settings for organizers/presenters 
and attendees. (e) 

• The Chat pane allows organizers and 
attendees to communicate privately or 
publicly and share Web sites. (f)  

As a Mac presenter with Mac OS 10.4, 
your expanded Control Panel will be 

visible to attendees as a black silhouette. At 
times, parts of the Control Panel can be fully 
visible (not blacked out) to attendees. This can 
obstruct a portion of what you are presenting. 
We recommend that Mac presenters leave the 
Control Panel collapsed as much as possible 
during the meeting. If you have a multi-monitor setup, we recommend keeping the Control Panel on your second monitor. 
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Screen Sharing Pane 
When an attendee becomes a presenter, the Control Panel adjusts to incorporate the Presenter Screen 
Sharing pane at the top. The Screen Sharing pane provides the presenter with access to the various 
presentation controls. 

• The Broadcasting Status field notifies 
presenters of the status of screen 
sharing. (a) 

• The Show My Screen button starts or 
pauses apresenter’s ability to show the 
entire desktop to attendees. (b) 

• The Screen drop-down button allows 
the presenter to share specific 
application windows, or a clean screen 
with meeting attendees. (c) 

• The Give Keyboard & Mouse button 
grants shared mouse and keyboard 
control to another attendee. (d) 

• The Change Presenter button passes 
the presenter role to another attendee. (e) 

Share Your Desktop 

 To share your entire desktop 

1. Click the Screen button on the GoToMeeting Control Panel. 
2. Select the preferred screen setting or a specific application.  
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Note: Hovering over your Show Only menu selection will display an animated gray frame which indicates what attendees will see if 
selected. If you select an application window that is minimized, the selected window will automatically maximize and be presented to 
attendees. If the presenter opens a window on top of the window being shared, screen sharing will pause until the intruding window 
is either moved or closed. 

Note: The specific application sharing feature will also allow you to share one or all of your multiple monitors if you have the 
hardware already set up.  

Note: To change the background color of a clean screen presentation, simply right-click on your desktop while you’re in that mode 
and pick from the available colors.   

Mac presenters do not have the option of displaying a clean screen or a specific application. We 
recommend you close any windows that you do not want attendees to see before beginning screen 
sharing. 

Pass Roles to Attendees 
Your keyboard and mouse controls can be temporarily 
shared with one of your attendees or the entire group. 
Simply click the Give Keyboard & Mouse button on 
the Screen Sharing pane or the Grab Tab and then 
select the attendee. As the presenter you will always 
have priority control of your keyboard and mouse, and 
can regain control simply by hitting a key or moving 
your mouse.  

If you would like to pass the presenter role to one of 
your attendees, simply click the Change Presenter 
button on the Screen Sharing pane or the Grab Tab and select the new presenter. 

To return the presenter role to yourself, click the Change Presenter button again and select your own 
name. 

Request Keyboard and Mouse 
Organizers and panelists can request keyboard and mouse control from the presenter. Right-click or 
Control-click your name in the Attendee List pane and select Request Keyboard & Mouse Control.  
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Manage Attendees 
Organizers can manage attendees by right-clicking or Control-clicking attendee names in the Attendee 
List pane and selecting or deselecting the desired attendee options. 

• Displays the number of attendees and maximum number of attendees for the meeting (a) 
• Indicates attendee role and color of assigned drawing tool (b) 
• Mute or unmute the attendee (c) 
• Mute or unmute all the attendees (d) 
• Assign an attendee the role of presenter and/or organizer (e) 
• Share your keyboard and mouse with  

an attendee (f) 
• Provide an attendee with on-screen drawing tools (g) 
• Choose pen color for yourself or your attendees (h) 
• Allow your attendee to see the list of other attendees (i) 
• Allow your attendee to chat (j) 
• Sends a chat message directly to the attendee (k) 
• Copy the attendees email address to the 

 clipboard (l) 
• Dismisses an attendee from the meeting (m) 

 



GoToMeeting® User Guide

© 2010 Citrix Online, LLC. All rights reserved. 52

Manage Audio 
When attendees join the audio portion of your meeting, they are unmuted by default. Attendees who 
connect via VoIP will have a microphone icon next to their name; attendees who connect via telephone 
will have a handset icon next to their name. For more information on audio options, please see 
GoToMeeting Integrated Audio. 

Note: Organizers should be aware that attendees joining with VoIP will not be able to participate in the audio portion of the meeting 
until the meeting is started. Attendees joining by telephone can communicate with other attendees at any time regardless of whether 
or not the meeting has started. 

Audio PIN 
Everyone who joins a meeting is provided a unique 
Audio PIN that, when entered, gives an organizer and 
attendee muting and unmuting control. Those joining by 
VoIP automatically have the Audio PIN assigned to 
them. Those joining by telephone are prompted to enter 
their Audio PIN when they first dial in. This unique PIN is 
displayed in the GoToMeeting waiting room as well as in 
the Audio pane of the Control Panel.  

 An Audio PIN can be entered on the telephone at 
anytime during the meeting by entering the # key, then 
the Audio PIN, followed by the # key a second time. 

  

Attendees Audio 
• This example shows that the 

presenter joined via 
telephone entered his Audio 
PIN and is currently 
unmuted. (a) 

• This attendee joined via 
telephone but did not enter 
her Audio PIN. (b) 

• This attendee joined via VoIP 
and is unmuted. (c) 

• Attendees who join the 
meeting via telephone must 
enter their Audio PIN so that 
you have full audio controls 
through the Organizer 
Control Panel. If not entered, 
you can right-click the 
person’s name and select 
Send Audio PIN. This will 
send a pop-up message with 
the Audio PIN to that person. 
(d) 
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Audio Control Icons 
Audio Control Icons 

 
Telephone: Unmuted (default) 

Can mute/unmute self through Control Panel or telephone keypad (*6) 

 
Telephone: Muted 

 
Telephone: Did not enter Audio PIN or has not yet joined the audio portion of the meeting. 

Cannot mute/unmute attendee until Audio PIN is entered.  

 
VoIP: Unmuted (default) 

Can mute/unmute self through Control Panel 

 
VoIP: Muted 

No  
icon 

Not connected to audio (cannot hear audio or speak). 
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Organizer Audio 
GoToMeeting integrated audio allows you to manage audio options before and during your meetings. If 
you wish to change your own connection or your attendees' audio connection during a meeting, you can 
do so from the Audio pane of your Control Panel. For more information about audio options, please see 
GoToMeeting Integrated Audio. 

Starting the Meeting 

• VoIP and Telephone: If you have 
selected to use VoIP and Telephone 
for your meeting, you will see the 
options Use Telephone and Use Mic 
& Speakers in your Control Panel. 
The default mode is Telephone; 
however, GoToMeeting will 
remember your selection for your next 
meeting. 

  

  

  

 

• Telephone: If you selected 
Telephone only for your meeting, you 
must join the audio portion by dialing 
the conference number and entering 
the access code and Audio PIN noted 
in the Control Panel. 

  

  

  

  

 

 To switch audio formats during a meeting

If you are using the GoToMeeting 
Conference Call Service during a 
meeting, you can switch between 
using Mic & Speakers or Telephone. 
In the Audio pane at Audio Mode, 
click either Use Telephone or Use Mic 
& Speakers. 
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 To edit audio services for your attendees

If you would like to provide your 
attendees different conference call 
options during a meeting, you may do so 
by clicking the Edit button in your Audio 
pane. 
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Muting Audio 
With GoToMeeting integrated audio, you can manage the muting and unmuting of individual attendees, 
switch audio formats and keep track of who is speaking.  For more information about audio options, 
please see GoToMeeting Integrated Audio. 

To manage muting and unmuting 
during a meeting 

You can mute/unmute yourself and 
attendees in the following ways: 

• Click the microphone or handset 
icon next to an attendee’s name. 
(a) 

• Click the microphone icon on the 
Grab Tab. (b) 

• Click the Mute All button. (c) 
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Chat with Attendees 
As an organizer, you can chat with your attendees by using the built-in Chat feature in the Chat pane. 
This feature can be turned on or off from the Meetings tab in the Preferences window or during a meeting 
from the Attendee List pane. 

• The Chat Log displays the text of all 
public chat and chat between two 
attendees. (a) 

• Share Web sites with attendees for easy 
navigation.(b) 

• The Message Entry field enables input of 
chat text. (c) 

• Send your chat message to all attendees 
or a specific attendee from the drop-down 
selection field. (d) 

• The Send button transmits chat to 
selected recipients.) (e) 

• Create a welcome message to be 
delivered to attendees when they arrive. 
(f) 

  

Mac organizers can edit welcome messages from the File drop-down menu in the toolbar.  
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Invite Attendees During a Meeting 
As an organizer, you can invite new attendees to meetings that are already in progress from the Attendee 
List pane. Invitation methods include phone, email and copy/paste. 

 

 Invite attendees by phone 

To invite attendees by phone, call the desired attendees and direct them to JoinGoToMeeting.com. Next, 
read them the meeting ID which can be found in the Invite Others window or at the bottom of your Control 
Panel. 

  

 Invite attendees by email 

To invite attendees by email, click the Invite Others button from the Attendee List and then click the 
Email button.  

A new Microsoft Outlook or IBM Lotus Notes email will be generated with the meeting invitation 
information in the body of the email; simply enter the email address and send the email to the desired 
attendees. 

Note: The email option works with Microsoft Outlook, IBM Lotus Notes and most PC based Email clients. If your Email application is 
not supported then simply click the Copy to Clipboard button and paste the meeting information into your email service. See 
Integration Preferences to learn more about Email integration. 

  

 Copy and paste the invitation 

To invite attendees using an email service other than Microsoft Outlook, click the Invite Others button 
from the Attendee List and then click the Copy to Clipboard button. 

This will copy the meeting invitation information to your clipboard, where it can then be pasted into 
another Email program or an instant-messaging application. 

http://www.joingotomeeting.com/�
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Grab Tab 
The Control Panel Grab Tab enables organizers and presenters to minimize the Control Panel and still 
access Presenter Screen Tools. There are four main display modes:  

1. The organizer/presenter has started meeting but no attendees have arrived. 
2. Attendees have arrived and the presenter is displaying his or her desktop. 
3. Attendees have arrived and the presenter has paused displaying his or her desktop. In this mode, 

screen sharing is paused and attendees see a frozen image of the presenter’s desktop. 
4. Attendees have arrived and the presenter has stopped displaying his or her desktop. In this mode, 

screen sharing is stopped and attendees see a “Presentation Stopped” message.  
• Click and drag to move Grab Tab up or down (a) 
• Click to hide or display Control Panel (b) 
• Shows On Air status (c) 
• Show My Screen button displays desktop to attendees. 
• Right-click to display multiple monitors, a specific application or a clean screen (d) 
• Stop Showing Screen button stops desktop display (e) 
• Give Keyboard & Mouse button grants shared mouse/keyboard control to  

another attendee (f) 
• Show Other’s Screen button passes the presenter role to another attendee (g) 
• Drawing Tools button allows the presenter to draw, highlight and place arrows on the 

screen, as well as use the spotlight and clear all markings (h) 
• Mute or unmute the microphone or telephone from attendees. (i) 

 

As a Mac presenter, your expanded Control Panel and Grab Tab will be visible to attendees as a black silhouette. 
Sometimes parts of the Control Panel are fully visible (not blacked out) to attendees. This can obstruct a portion of what 
you are presenting. We recommend that Mac presenters leave the Control Panel collapsed as much as possible during the 

meeting. If you have a multi-monitor setup, we recommend keeping the Control Panel on your second monitor. 
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Drawing Tools 
The Drawing Tools feature is accessed from 
the Drawing Tool button on the 
GoToMeeting Grab Tab. Once a drawing 
tool is enabled, the Drawing Tools menu can 
be reselected by either clicking the Drawing 
Tool button or by right-clicking your mouse. 
To deactivate a tool, simply select Normal 
non-drawing mode from the menu.  

• No drawing tool selected (a) 
• Click and drag to draw on the screen 

(b) 
• Click and drag to highlight in yellow 

(c) 
• Allows the presenter to draw attention 

to an area of the screen without 
leaving a mark (d) 

• Places an arrow on the screen (only 
one arrow at a time) (e) 

• Erases all presenter and attendee 
drawings (f) 

• Enables Attendee Drawing Tools 
during a meeting (g) 

• Customize the color of the pen tool. 
(h) 

Note: Press the Shift key with any drawing tool to make 
a straight line. 

Note: Only the presenter can erase drawings. Drawing 
will pause for attendees anytime the presenter pauses 
the presentation.  

  

  

  

  

The Drawing Tools feature is currently only available for meetings hosted by PC users. 
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Choose Pen Color 
The Drawing Tool feature can be customized to display a preferred pen color while interacting with the 
screen. Once enabled, you and your attendees can modify the pen color either from the Drawing Tool 
button on the Grab Tab or by right-clicking on a name in the attendee list. 

 

  



GoToMeeting® User Guide

© 2010 Citrix Online, LLC. All rights reserved. 62

Menu Bar - PC Users 
The Organizer Control Panel menu bar provides access to various application tools not specifically 
related to managing meetings. Menu options include File, Options, View and Help.  

  

File Menu 

From the File menu, PC-based organizers can edit how 
their names and email addresses are displayed to 
attendees. They can change the meeting subject, save 
the chat logs of their meetings as .rtf files to their PCs and 
access Preferences while in session. Organizers can also 
exit meetings without ending them (they must first make 
another attendee an organizer) or exit meetings and end 
them. 

  

Options Menu 

From the Options menu, organizers can enable or disable 
the Attendee List and/or Chat feature for all attendees. 

  

View Menu  

From the View menu, organizers can record the meeting. 
Organizer can also return the Control Panel layout to its 
default settings or save the current layout. 

With Auto-Hide the Control Panel checked your Control 
Panel is set to collapse automatically after 10 seconds of 
inactivity. To disable this feature, deselect the Auto-Hide 
the Control Panel option in the View menu. 

  

Help Menu 

The Help menu provides access to the online 
GoToMeeting help file, Audio Feedback and GoToMeeting 
software version information. 
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Toolbar - Mac Users 

GoToMeeting Menu 

The GoToMeeting menu allows Mac-based 
organizers to manage their preferences and end a 
meeting. 

 
File Menu 

The File menu allows organizers to edit how their 
names and email addresses are displayed to other 
attendees, save the meeting chat logs as .html files 
and leave meetings. 

View Menu 

The View menu enables organizers to select how to 
display the Viewer Window on their desktops.   

Audio Menu 

The Audio menu provides organizers another option 
for managing their audio settings. They can mute 
themselves, switch between telephone and VoIP if 
enabled and select their audio input/output.  

 
Help Menu 

The Help menu provides access to the online GoToMeeting help file and to GoToMeeting 
software version information. There is also an option to leave feedback on the audio quality.  
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Record and Play a Meeting 
Notes on Recording and Playing a Meeting 
Meeting recording allows an organizer to record all screen activity that is presented in the GoToMeeting 
Viewer Window, including desktop and application sharing of other attendees presenting during the 
meeting. 

See the System Requirements section of this guide for requirements to record a meeting.  

Before recording a meeting, an organizer must set recording preferences, including selecting the audio 
format and recording media format (either GoToMeeting format or Windows Media Player format). If the 
Windows Media Player format is selected, GoToMeeting will begin an automatic conversion process 
immediately after a meeting has ended. Allow time for the conversion to take place. The time needed is 
dependant upon video content, CPU speed and amount of memory available. 

To record the audio portion of your session, an organizer must have a sound card installed on his or her 
computer. To record using the GoToMeeting integrated audio feature, an organizer can use the telephone 
or a microphone connected to his or her computer. To record using the organizer’s private audio service, 
an organizer must have a phone patch connected to both the phone and the “mic in” port of his or her 
computer.   

Only one recording file is created per meeting. This means that if an organizer clicks Record to start the 
recording, then stops the recording and subsequently restarts the recording during the course of one 
meeting, GoToMeeting will continue recording to one meeting recording file. 

The default destination location to save a recording defaults to the My Documents folder. An organizer 
can change the destination location but only before beginning recording. It is recommended that the 
designated location have a minimum of 1 GB of free space in order to accommodate the recording. For 
optimum recording performance and in-session experience, it is recommended that you select a location 
on your local hard drive. 
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Record a Meeting 
The Desktop Recording and Meeting Playback feature is only available to meeting organizers or 
promoted organizers. 

Note: To avoid a recorded meeting with a blank screen, please ensure the presenter initiates some type of screen action (such as 
advancing a presentation slide) after clicking the Start Recording button. If recording begins before the presenter shares his or her 
screen and there is no screen action then the finished recording will only include a blank screen and audio.  

The Desktop Recording and Meeting Playback feature is only available to PC-based meeting 
organizers or promoted organizers. 

  To configure recording settings 

1. From the Organizer Control Panel, click the View 
menu, select Recording and then click Settings.  

2. On the Recording tab: 

  

  

  

  

  

• Audio - Allows you to 
enable or disable the 
audio recording feature. 
To record, choose which 
audio service you want to 
use for your meeting. 
Note: Be sure to check your 
audio device settings under 
Audio in the left menu. 

• Video - Allows you to 
select the meeting 
recording output format 
and destination for saving 
the file.  
Note: Mac users can only view 
meetings recorded in Windows 
Media Player format.  

• Save in - Select the folder 
in which you want to save 
your recording. 

3. Click OK. 
Note: If you are using VoIP, see the 
GoToMeeting Integrated Audio section 
for information on testing your audio 
device.  

Note: For optimum recording performance and in-session experience, it is recommended that you select a location on your local 
hard drive. 
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Note: You cannot change the input device setting or the "Save in" location setting once you have started to record a meeting. If you 
do not specify a destination location, the default is My Documents. 
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 To record a meeting 

1. From the Organizer Control Panel, click 
the View menu and select Recording. 

2. Click Settings in the Recording pane 
and confirm that your Audio and Video 
options are set appropriately. For 
detailed Audio and Video options, click 
on the Need Audio Help? link and 
Learn More links respectively. 

3. In the "Save in" section, click the 
Browse button to identify where you 
would like to save your recording. 

4. Click OK to save your settings. 
5. In the Recording pane, click the Start 

Recording button to start recording. 
6. Click Show My Screen to capture the 

video portion of the recording. 
7. Click File and select Exit - End Meeting.

  

Note: The lower you set your monitor resolution, the better the quality of the meeting recording. A resolution of 1024 x 768 is ideal 
for optimal recording quality. Since the recording will scale to the highest resolution among the presenters in a recorded meeting, it 
is also recommended that all presenters synchronize their resolution settings to the same setting. Avoid displaying multiple monitors 
when recording a meeting. 

Note: You must have at least 500 MB of space on the destination drive to record a meeting. If you have less than 500 MB of 
available space, GoToMeeting will display a warning when recording begins. If space drops to 100 MB, recording will be 
automatically stopped and you will receive a warning message. If you have selected to convert your recording to Windows Media 
format, you will need 1 GB (twice as much space).The Remaining field in the Recording pane refers to the amount of space 
available for recording that is listed in the Recording Preferences Save In field. 
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Play a Recorded Meeting 
GoToMeeting creates one recording file per meeting. If you stop and start a recording during the course 
of a meeting, each recorded segment will be appended to the recording file in progress for that meeting. 

 To replay a meeting recorded in the GoToMeeting format 

1. If you haven’t already, end the meeting that you are recording and GoToMeeting will automatically 
save your file with the date and time noted after the name that you gave the meeting upon 
scheduling it. Impromptu meetings will be named with the date and time of the meeting followed by 
Meet Now. 

2. Navigate to the directory that is listed in the Save in: field under the Preferences Recording tab. 
3. Click the file name to start the replay. 
4. Press Alt and Enter on your keyboard at the same time to maximize the Viewer Window for best 

replay quality. 
  

Note: You must have GoToMeeting installed, or download the GoToMeeting codec to view a meeting recorded in the GoToMeeting 
format. Visit http://www.garmenting.com/codec to download the codec. Mac users cannot view meetings recorded in GoToMeeting 
codec format. 

Note: Playing a recorded meeting back before ending the meeting may cause abnormal playback behavior.  Be sure to end the 
meeting before playing it back. 

 To replay a meeting recorded in the Windows Media format 

1. If you haven’t already, end the meeting that you are recording. 
2. GoToMeeting will save your file with the name that you gave the meeting upon scheduling it or 

Meet Now plus the date and time of the meeting and will immediately begin converting the 
recording file into the Windows Media format. 

3. Upon completion of the conversion process, navigate to the directory that is listed as the Save in: 
field under the Preferences Recording tab. 

4. Click the file name to start the replay. 
5. Press Alt and Enter on your keyboard at the same time to maximize the Viewer Window for best 

replay quality. 
Note: The conversion process begins automatically, immediately after you end a recorded meeting in the Windows Media format. 
Allow time for the conversion to take place. The time needed is dependant upon video content, CPU speed and amount of memory 
available. Due to the use of CPU resources, you may have to wait until the conversion process is complete to resume use of the 
computer. GoToMeeting converts the recorded meeting into a Windows Media Player file after the meeting is over, instead of 
recording directly to Windows Media format. This ensures that, the impact on CPU resources doesn’t bog down the computer during 
the meeting. 

Note: Playing a recorded meeting back before ending the meeting may cause abnormal playback behavior. Be sure to end the 
meeting before playing it back. 

http://www.gotomeeting.com/codec�
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Distribute a Recorded Meeting 
Depending on the size, meeting recordings can be zipped and sent by email, sent by FTP or posted on a 
Web site. 

 To distribute a recorded meeting in the GoToMeeting format 

1. Deliver the recorded meeting by email or FTP or post to a Web site. 
2. Recipients must have Windows Media 9 or higher to view the recorded meeting. 
3. Ask recipients to install the GoToMeeting codec at http://www.gotomeeting.com/codec if not 

already installed or if recipients are not running the GoToMeeting software on their computers. 

 To distribute a recorded meeting in the Windows Media format 

1. Upon completion of the conversion process, deliver the recorded meeting by email or FTP or post 
to a Web site. 

2. Recipients must have Windows Media 9 or higher to view the recorded meeting. 

Troubleshoot Recording and Replaying a Meeting 

  To troubleshoot recording and playback 

• Please see the Need audio help? and Learn more. These pages are also linked from the 
Recording category of the organizer Preferences menu. 

Download Windows Media Player 
In order to record a meeting, you must have Windows Media Player 9 or newer.  

 To download Windows Media Player 

1. Go to the Microsoft Windows Media Web site and follow the prompts to download the most recent 
version of Microsoft Windows Media Player. 

Note: Meeting recording requires Windows Media Player 9.0 or higher. Windows Media Player 9.0 currently supports Windows® 
2000, XP Home, XP Pro and 2003 Server; therefore, these are the operating systems required for recording with GoToMeeting. 

http://www.gotomeeting.com/codec�
http://www.microsoft.com/windows/windowsmedia/default.aspx�


GoToMeeting® User Guide

© 2010 Citrix Online, LLC. All rights reserved. 70

Attending Meetings 
Attendee Role Overview 

• A meeting attendee can be any person with an Internet connection. All that is needed to join a 
meeting is the meeting ID and, if required, the meeting password. Attendees do not need to 
subscribe to GoToMeeting; they meet at no cost to them as guests of the organizer. 

• Attendees may be given the role of organizer and/or presenter from the original meeting organizer 
at any time once a meeting has started. 

Join a Meeting 
There are several ways to join a meeting depending on how you receive the meeting invitation. Joining a 
meeting requires no pre-registration or configuration. 

Note: When joining a meeting, remember to also conference into the meeting using the conference call information provided by your 
meeting organizer. 

  To join a meeting from an email invitation, Outlook or Lotus Notes meeting appointment or 
instant message 

1. Open the email, appointment or instant message that contains the meeting invitation. 
2. Click the link provided in the email to join the meeting. 
3. If prompted, click Yes, Grant or Trust to accept the download. 
4. If requested, enter the meeting password provided by your meeting organizer. 
5. When prompted, type in your name and optionally, your email address. 

Upon clicking OK in the Name and Email dialog, you will be entered into the meeting. The 
Attendee Control Panel and the GoToMeeting Viewer window will appear. 

 To join a meeting from the GoToMeeting Web site 

1. Open an Internet browser and go to www.gotomeeting.com. 
Note: Attendees can also join meetings from www.joingotomeeting.com.  

2. In the left-navigation bar click the Join Meeting button. 
3. If prompted, click Yes, Grant or Trust to accept the download. 
4. On the Join a Meeting window, enter the meeting ID you received from your meeting organizer. 
5. If requested, enter the meeting password provided by your meeting organizer. 
6. When prompted, type in your name and optionally, your email address. 

Upon clicking OK in the Name and Email dialog, you will be entered into the meeting. The 
Attendee Control Panel and the GoToMeeting Viewer window will appear. 

https://www1.gotomeeting.com/�
https://www.joingotomeeting.com/�
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 To join a meeting from your desktop 

1. If you are an organizer and GoToMeeting is already installed on your computer, you can right-click 
the  icon in the PC system tray or double-click the GoToMeeting icon on a Mac and select Join 
a Meeting. 

2. On the Join a meeting window, enter the meeting ID you received from your meeting organizer. 
3. If requested, enter the meeting password provided by your meeting organizer. 
4. When prompted, type in your name and optionally, your email address. 

Upon clicking OK in the Name and Email window, you enter into the meeting. The Attendee 
Control Panel and the GoToMeeting Viewer window appear. 
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Attendee Viewer and Control Panel 
Once attendees join a meeting they see two GoToMeeting attendee components, the GoToMeeting 
Viewer window (a) and the GoToMeeting Attendee Control Panel (b). 
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Attendee Control Panel 
When attendees first join a meeting, the 
Attendee Control Panel appears on the 
right side of their desktops. The 
Attendee Control Panel gives attendees 
access to various meeting functions and 
is comprised of four panes: the Attendee 
List Pane, the Audio Pane, the 
Chat Pane, and Grab Tab. 

After approximately 10 seconds the 
Attendee Control Panel automatically 
collapses to the right side of the screen 
with only the Grab Tab displayed. The 
auto-collapse feature can be disabled 
from the View drop-down menu. 

 The option to disable the auto-
hide feature on the Control Panel is only 
available to attendees using PCs. 

• Attendee List Pane - If enabled by 
the organizer, provides a list of all 
meeting attendees. (a) 

• Grab Tab - Enables attendees to 
minimize the Control Panel to the 
side of their desktops and still 
access Viewer tools. (b) 

• Audio Pane - If the organizer has 
given attendees a choice in how 
to join the audio portion of the 
meeting, you can switch between 
using Mic & Speakers (VoIP) or 
Telephone. (c) 

• Chat Pane - If enabled by the 
organizer, allows attendees to 
chat with other attendees, either 
individually or all at once, or with 
just the organizer or presenter  (d) 

• Meeting Information - Provided for quick reference. (e) 
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Attendee Control Panel Menu Bar - PC Users 
The Attendee Control Panel menu bar provides access to various application tools not specifically related 
to attending a meeting. Menu options include File, View, Tools and Help. 

File Menu 

The File menu allows PC-based attendees to edit how their names and 
email addresses are displayed to other attendees, save the meeting 
chat logs as .rtf files, manage their preferences and exit meetings. 

From the Preferences menu, attendees can allow or forbid bubble 
messages to appear when another attendee chats or when 
GoToMeeting notifies them of system-related actions such as attendees 
joining or leaving a meeting. 

    

View Menu 

The View menu enables attendees to select how to display the Viewer 
window on their desktops and how the Control Panel behaves when not 
in use.  Attendees can also save a customized layout or return to the 
Control Panel to the default layout. 

Help Menu 

The Help menu provides access to the online GoToMeeting Help file 
and to GoToMeeting software version information. There is also an 
option to leave feedback on the audio quality. 
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The Attendee Toolbar - Mac Users 

GoToMeeting Menu 

The GoToMeeting menu allows attendees to manage their 
Preferences and exit GoToMeeting. 

File Menu 

The File menu allows attendees to edit how their names and 
email addresses are displayed to other attendees, save the 
meeting chat logs as .html files and leave meetings. 

View Menu 

The View menu enables attendees to select how to display the 
Viewer window on their desktops. 

Audio Menu 

The Audio menu provides attendees another option for 
managing their audio settings. They can mute themselves, 
switch between telephone and VoIP (if enabled) and select their 
audio input and output. 

Help Menu 

The Help menu provides access to the online GoToMeeting Help file and to GoToMeeting software 
version information. There is also an option to leave feedback on the audio quality.  



GoToMeeting® User Guide

© 2010 Citrix Online, LLC. All rights reserved. 76

Attendee Control Panel Grab Tab 
The Attendee Control Panel Grab Tab enables attendees to minimize the Control Panel to the side of 
their desktops and change the way the presenter’s desktop is displayed in the Viewer window. The Grab 
Tab changes depending on the status of the Viewer window. 

  Attendee Grab Tab with 
Viewer in Window Mode 

Attendee Grab 
Tab with Viewer 
in Full- Screen 

Mode 

Attendee Grab Tab 
with Drawing Tools 

Enabled by 
Presenter 

Click and drag 
to move Grab 
Tab up or down 
(a) 

 
 

 

Click to hide or 
display Control 
Panel (b) 

Click the View 
button to change 
display modes 
(c) 

Click to mute or 
unmute  
yourself (d) 

Click and drag 
to move Grab 
Tab up or down 
(e) 
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Attendee Drawing Tools 
Drawing Tools must be enabled by the presenter before they appear to attendees. The presenter is the 
only one who can erase drawings. Drawing will pause when the presenter pauses the presentation. 

   

 To use a Drawing Tool 

1. Click the Select Drawing Tool button on the Attendee 
Grab Tab. 

2. Select the desired tool from the Drawing Tools drop-
down menu. 
  

Note: Once the drawing feature is selected, you can right-click anywhere on 
the Viewer window to change the drawing tool or return to non-drawing mode. 

Note: The pen color can be changed from the Drawing Tools drop-down menu.  

  

 To disable a drawing tool 

1. Click the Select Drawing Tool button on the Attendee 
Grab Tab. 

2. Select Normal non-drawing mode. 

Or 

1. Right-click/Control-click anywhere on the Viewer window. 
2. Select Normal non-drawing mode from the Drawing Tools drop-down menu. 

Or 

Press the Esc key to disable a drawing tool without going to the Grab Tab or Control Panel. 
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Chat with Other Attendees 
If enabled by the organizer, attendees can chat with other attendees by using the built-in Chat feature in 
the Chat Pane. Or, attendees can just chat with the organizer or presenter. 

• The chat log displays the text of all public chat and chat between two attendees. (a) 
• The Message Entry field enables input of chat text. (b) 
• The Send Chat to: field enables selection of chat recipients. (c) 
• The Send button transmits chat to selected recipient(s). (d) 

 

 To chat with attendees 

1. Select the desired recipient(s) from the Send Chat to: drop-down selection field. 
2. Enter desired chat message in the Message Entry field. 
3. Click the Send button. 

 To reply to a chat message 

1. Select the desired recipient(s) from the Send Chat To: drop-down selection field. 
- Or- 

1. Click the attendee’s name within the Message Entry field. 
2. Enter desired chat message in the Message Entry field. 
3. Click the Send button. 

To save a chat log 

1. Under the File menu, select Save Chat Log. 
2. This opens the Save Chat Log to a File window that allows you to store the file locally. Then 

browse to the location where you would like to save it. 

To auto-save chat logs 

1. Click the General category on the GoToMeeting Preferences window and select Chat Logs. 
2. In the Save in: box, click Browse and select the desired directory. 
3. Click OK. 
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Attendee Viewer Window 
The Viewer window is where the image of the presenter’s desktop is displayed to attendees. The Viewer 
window can be displayed in either a Window Mode or a Full-Screen Mode. 

In Window Mode, 
the presenter’s 
desktop is 
contained within 
a scaleable 
window. 

 

Full Screen 
Mode 
expands the 
presenter’s 
desktop 
completely 
over your 
own. The 
Attendee 
Control 
Panel/Grab 
Tab remains 
accessible. 

 

 To change the Viewer window mode 

• Click the Window Mode button from the 
Grab Tab. 

Or 

• Select Window or Full Screen from the View 
menu on the Control Panel.  
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Share Presenter Mouse and Keyboard 
At any time during a meeting, presenters may share control of their keyboard and mouse with any other 
attendee. This enables the designated attendee to share control of applications on the desktop being 
displayed. 

When an attendee is given shared control, the GoToMeeting application notifies all attendees of the 
change in control by providing a System Bubble Message. 

 
Note: Even though an attendee may gain shared keyboard and mouse control of the presenter’s desktop, the presenter always 
retains overriding control by simply moving his or her mouse. 
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Become a Presenter 
At any time during a meeting the presenter may pass the presenter role to any other attendee allowing 
the designated attendee to share the presenter's desktop screen. 

When an attendee is made a presenter the GoToMeeting application shows a dialog box notifying the 
attendee that he or she has been made presenter and updates his or her Control Panel and Grab Tab 
with Presenter Tools. 

The new PC-based presenter can click Show My Screen to present his or her entire desktop (a) 
or click the down arrow to select a specific application window (b). For more information about 
being a presenter, please see the Organizer/Presenter Control Panel section. 

 
 

Mac attendees can share their entire desktop but not a specific application. 

  

 

Become an Organizer 
At any time during a meeting, the organizer may promote any attendee to the role of co-organizer to 
enable that attendee to share meeting management functions. 

When an attendee is promoted to the role of co-organizer, the GoToMeeting application notifies the 
attendee of the change by providing a System Bubble Message and updates his or her Control Panel and 
Grab Tab with Organizer Tools. 

For more information about being an organizer, please see the Organizer/Presenter Control Panel 
section. 

 



GoToMeeting® User Guide

© 2010 Citrix Online, LLC. All rights reserved. 82

Leave a Meeting 
An attendee may leave a meeting at any time. 

 To leave a meeting 

1. From the File menu on the Attendee Control Panel, select Exit – Leave Meeting. 
2. Click Yes on the Leave Meeting? window.  

On the GoToMeeting menu bar, select GoToMeeting and then Quit GoToMeeting; or, select File 
and then Leave Meeting. You may also click the red X in the top-left corner of the Control Panel 

and Viewer window. 
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The GoToMeeting Organizer Web Site 
 View your account information, scheduled meetings and meeting history by logging into the 
GoToMeeting Web site. Learn how to schedule an upcoming meeting from the Schedule Meetings 
section.  

Log In to Your Organizer Web Site 
To access the organizer Web site features, organizers must first log in. 

 To log in to your organizer Web site 

1. Go to www.gotomeeting.com and click Log In from the top-right of the welcome screen. 

2. Enter your email address and password in the Returning Users section, and click Log In. 

My Account 
The My Account page enables organizers to view and edit their personal account information, change 
passwords, set conference call preferences and view billing information and account history. 

 To edit account information 

1. Log in to the organizer Web site. 
2. In the left navigation bar, select My Account. 
3. At the top of the My Account section, enter your current password, make any desired account or 

password changes and click the Save Changes button at the bottom of the page. 

Change Account Password 
For improved security you may want to occasionally change your account password. If your account has 
a company administrator, he or she may require you to change your account password on a regular 
basis. 

  To change your account password 

1. After you sign in, select My Account from the left-navigation bar. 
2. Enter your current password at the top of the My Account Details section. 
3. Enter and confirm your new password . 
4. Click the Save Changes button at the bottom of the page. 

Note: Your new password must contain at least 8 characters and include both letters and numbers. 

https://www1.gotomeeting.com/�
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Audio Conference Options 
The Audio Conference Option section of the organizer Web site allows you to set your default audio 
preferences. If you select Both, your attendees will have the choice of dialing in with a provided 
conference call number or connecting with VoIP. Alternatively, you can provide your own conference call 
number(s) in this section. You can override your default settings while scheduling a meeting or during a 
meeting from the Present Control Panel.   

Related Topics 

 To set audio conference options 

1. After you sign in, select  My Account from the left-navigation bar. 
2. At the top of the My Account Details section, enter your current password. 
3. Select the default audio service(s) you wish to include with your meetings. To provide local toll 

numbers for multiple countries, click the Add more countries link. 
4. Click the Save Changes button at the bottom of the page. Changes apply to all scheduled and 

future meetings.  

 

Cancel Your Account or Update Billing Information (Individual Only) 
If you are an individual GoToMeeting user then you can update your credit card and billing information 
very easily by logging in at www.gotomeeting.com and selecting Billing Information from the expanded My 
Account menu in the left navigation pane. 

Note: This feature only appears for individual GoToMeeting organizers and does not apply to GoToMeeting Corporate organizers 

 To edit account billing information 

1. Log in and select My Account from the left navigation bar. 
2. Click Billing Information from the expanded menu. 
3. Make any desired credit card or billing address changes and then click Save Changes at the 

bottom of the page. 

http://www.gotomeeting.com/�
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Renew or Cancel GoToMeeting (Individual Only) 
With Subscription Options you can decide what will happen with your GoToMeeting account after the 
current plan expires. 

 To renew or cancel GoToMeeting after the current plan expires 

1. Log in and select My Account from the left navigation bar. 
2. Click Billing Information from the expanded menu. 
3. From the Subscriptions Options section, select an option once the current plan expires. 

Note: You can also contact Global Customer Service to cancel your account. 

Note: Because GoToMeeting service is a pre-paid , your service will continue until the end of your current paid subscription period. 
At that time, your plan will be discontinued and will not renew again. 

 

http://support.gotomeeting.com/ics/support/default.asp?deptID=5641&task=knowledge&questionID=4412�
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Plan Selection (Individual Only) 
The Plan Selection section enables individual GoToMeeting organizers to view and edit their 
GoToMeeting plan.  

Note: This feature only appears for individual GoToMeeting organizers and does not apply to GoToMeeting Corporate organizers. 

 To purchase or change your billing plan 

1. After you sign in, select My Account from the left-navigation bar. 
2. Select  Plan Selection from the expanded menu. 
3. Select a product and choose either a monthly or annual plan and then click Review Your Plan. 
4. Enter or confirm your billing information and click Buy. 
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View Account History (Individual Only) 
If you are an individual GoToMeeting user you can review your account activity and print receipts by 
logging into your account at and selecting Account History from the expanded My Account menu. 

Note: This feature only appears for individual GoToMeeting organizers and does not apply to GoToMeeting Corporate organizers. 
Corporate customers should contact their account manager for account and billing related questions. 

 To view your account billing information 

1. In the left-navigation bar, click the My Account link. 
2. Click Account History from the expanded menu. All billing activity since account creation is 

displayed. 
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My Meetings 
The My Meetings section enables organizers to manage their scheduled meetings and review their 
meeting history. See Scheduling Meetings for information on creating new meetings. 

View Scheduled Meetings 
Your scheduled meetings are first displayed when you log in to your organizer Web site. Scheduled 
meetings can also be viewed by selecting My Meetings in the left-navigation bar. Meetings can be started 
or ended from this page and meetings currently in session can be joined. 

 To view scheduled meetings 

1. Log in to the organizer Web site.  
2. The My Meetings page is displayed with a list of your scheduled meetings along with meetings that 

are currently in session. The meeting subject, start date and time are displayed.  
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View Meeting History 
View a report of your completed meetings with the Meeting History section of the organizer Web site. 
Details include, meeting subject, date/time, duration and number of attendees. The attendee names, 
email addresses and join/leave times can also be reviewed. 

Note: GoToMeeting Corporate organizers can view up to 12 months of meeting data. Individual GoToMeeting organizers can view 
90 days worth.  

 To view meeting history 

1. After you sign in, click My Meetings and then Meeting History from the left navigation bar. 
2. Select the time frame and click the Show History button. 
3. Click the number in the attendee column to display attendee names, email addresses and 

join/leave times. 
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Tips for Success 
Prior to Meeting or Event Start 

• If you plan to share your entire desktop, turn off any instant-messaging applications, notification 
software or other programs that may interrupt or distract from the meeting.  

• Turn off any streaming media applications that may take up bandwidth and resource-intensive 
applications that may be taxing processor ability.  

• Set the desktop display to a neutral background and adjust display settings to a mid-range 
resolution (e.g., 1024 x 768) to improve the display for attendees with lesser settings. This is also 
the optimal setting for recording a meeting. 

• Clean up your desktop before a meeting. Eliminate wallpaper and icons that may distract your 
attendees. 

• Have the documents you wish to share ready to be accessed in one or two clicks. 
• Run a trial meeting with a friend to anticipate questions and to familiarize yourself with the format 

of your online presentation. 

Managing the Meeting 
• Arrive a few minutes early to greet the attendees as they arrive and start the meeting on time. It 

also helps to have a welcome presentation running during this time. Your presence in these 
opening minutes can help establish the tone and direction of the meeting. 

• Create a welcome message under the Meetings category of Preferences to greet your attendees 
as they arrive at the meeting. 

• Provide an agenda at the start of the meeting, including estimated duration, and stick to it. 
• Inform attendees what the purpose/goal of the meeting is, what to expect and when and how to 

ask questions and participate in the meeting.  
• Provide information on how to use equipment or services and how to get assistance if needed. 
• Nominate a co-organizer to monitor and respond to the chat log when someone is presenting. 
• Encourage participation by using open questions such as “What would you suggest?” and “How do 

you feel about?” 
• End the meeting clearly. Make sure all the attendees know that the meeting is formally over and 

stay on the line to address any last questions. 

Managing the Conference Call 
• Call in to the meeting from a location where there is little background noise. 
• Consider globally muting participants at the start of the meeting to avoid noise issues. Turn off 

system prompts and sounds for when attendees join or leave a meeting. Read the Voice 
Conferencing section of the help files to familiarize yourself with the conference call features. 

• Avoid using cellular and cordless phones because of static and use the phone handset or a 
headset instead of speakerphones because of background noise, tunnel effect and sentence 
clipping. 

• Turn off your call waiting. The beep of a new call on another line is heard by everyone on the 
teleconference. 

• Avoid putting your phone on hold during a teleconference. Your hold music will play into the 
conference call, and make it impossible for the other attendees to continue the meeting. 

• Introduce yourself when you begin speaking and ask other attendees to also identify themselves 
before speaking. Not everyone in the meeting may know everyone else’s voice. 

• If you find you are having a sound quality issue, hang up and dial back in. Sometimes these 
problems clear themselves up when the bad connection is terminated. 
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Troubleshooting and FAQs 
General GoToMeeting FAQs 
I never received my meeting organizer invitation email. What should I do? 

It’s possible that your email server blocked the invitation email. If you do not have the ability to check 
email in a spam folder, check with your Administrator to see if the invitation can be resent. Otherwise, ask 
your administrator to contact the GoToMeeting account manager for help. 

  

How can I view scheduled meetings? 

To see what meetings you have scheduled, right-click the   icon in the system tray or double-click the 
GoToMeeting Suite icon on a Mac and select My Meetings. After your login email address is verified, you 
will see the list of scheduled meetings. 

You can also log in to www.gotomeeting.com and view your scheduled meetings. 

  

I forgot my password. What should I do? 

First, make sure you are entering your correct login email address and password. Note that your 
password is case sensitive and must contain at least 8 characters and include numbers and letters. 

If you still need to reset your password, just visit 
https://www.gotomeeting.com/en_US/forgotpassword/forgotPassword.tmpl and enter your email address. 
You can also reach this page via the www.gotomeeting.com login page. An email will automatically be 
sent to your login email address to reset your password. 

  

How long will my past meetings appear in my Meeting History? 

Past meetings will appear in your Meeting History for 90 days, after which they will be deleted from the 
system. If you would like to keep records of your meetings for auditing purposes, have your administrator 
run a Meeting History report at least once every 90 days and then save it locally. 

  

Why does the meeting pause when I open a window that I am not sharing? 

The application-sharing feature is set up to ensure that you are only sharing the specific window that you 
have selected. If you inadvertently open a different window, GoToMeeting will automatically pause the 
meeting to protect your privacy. Screen sharing will resume once you have moved or closed the 
obstructing window. The Specific Application Sharing feature is only available to PC users.  

  

What happens when I stop showing my screen? What do my attendees see? 

When you click the Stop button, screen sharing will be turned off and you will no longer transmit your 
desktop contents to your attendees. Instead, your attendees will see the Waiting Room screen until you 
click the Play button to resume screen sharing. Upon request, GoToMeeting Corporate users can display 
their company logo on the Waiting Room screen. 

https://www1.gotomeeting.com/�
https://www.gotomeeting.com/en_US/forgotpassword/forgotPassword.tmpl�
https://www1.gotomeeting.com/�
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How do I share one application and nothing else? 

A presenter can share a single application by right-clicking the screen-sharing icon on the Control Panel 
Grab Tab and then selecting the application to share from the list of applications presented. The 
application-sharing feature is only available to PC users.  

  

After I've given keyboard and mouse control away, how do I get it back? 

As a security feature, you can regain control of your desktop/laptop by simply moving your mouse. The 
change of control happens almost instantaneously. At any time, you can revoke an attendee’s shared 
control of your mouse and keyboard if you want to prevent him or her from regaining control. 

  

Are there any files or folders left on an attendee's computer after the session ends? 

Some downloaded files do remain after a meeting so that the attendee may join future meetings more 
quickly (without having to download all the files again). However, the files are inactive, will not consume 
system resources, do not compromise security and perform no functions until the attendee joins another 
meeting and the files are engaged by a new meeting ID. If desired, an attendee may uninstall all 
GoToMeeting files using the Add/Remove Programs feature in the Windows control panel.   

  

Why would I make someone else an organizer in my meeting? 

If you created a meeting and needed to leave, but wanted your attendees to continue the discussion, you 
would want to make someone else the organizer. The meeting would proceed without you without 
interruption. Or, you could appoint a co-organizer to monitor and respond to attendee chat questions 
while you focused on the task of presenting. 

  

Is there a charge for using the integrated conference call service or VoIP?  

GoToMeeting is packaged with both VoIP and a phone conferencing service at no extra cost to you. You 
may decide to use one or both of these services or choose another method of bringing audio to your 
online meetings. Our phone conference service provides a toll-based number that is dialed by all meeting 
participants. Participants are then charged their standard long-distance rate for calling this toll-based 
number, just as if they made a regular long-distance call. There is no additional charge for the 
conferencing feature. If attendees wish to avoid incurring long-distance charges, then they can join the 
meeting with VoIP. Please see Integrated Toll-Free Audio for information on how to provide your 
attendees a toll-free option. 

  

How do I save chat sessions from my meetings?  

Under the File menu, select Save Chat Log. This opens the Save Chat Log to a file window that allows 
you to store the chat log locally. Or, if you are using a PC, under the General category of your 
GoToMeeting Preferences, you can check the box marked Chat Logs to automatically save your chat 
logs to your local computer after each meeting. 

  

Where can I find instructions for the integrated conference call service? 

Conference call information for organizers is available in the GoToMeeting Integrated Audio section. 
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Is training available for GoToMeeting? 

Yes, please see the Product Training section for more information.  

  

Is there an attendee? How can I view information about past attendees? 

Log in to www.gotomeeting.com with your email address and password. Select My Meetings from the 
menu options on the left. Select Meeting History from the sub-menu options. 

The information is grouped by month. You can see your meetings in chronological order. Each meeting 
contains the number of attendees (shown in blue) - when you click this number, a window opens listing 
the attendees’ first and last names, their email addresses and their join/leave times. This information can 
be copied into another document. 

  

Are Mac or Linux operating systems supported with GoToMeeting? 

Currently Linux operating systems are not supported by GoToMeeting, either to host or join a meeting. 
However, GoToMeeting does support Mac-based organizers and attendees. 

  

As a Mac presenter, is my GoToMeeting Control Panel visible to my attendees? 

If you’re using Mac OS 10.4, your grab tab and expanded Control Panel are visible to attendees as a 
black silhouette. At times, parts of the Control Panel can be fully visible (not blacked out) to attendees. 
This can obstruct a portion of what you are presenting. We recommend that Mac OS 10.4 users leave the 
Control Panel collapsed as much as possible during the meeting. If you have a multi-monitor setup, we 
recommend keeping the Control Panel on your second monitor. The silhouetted Control Panel is not an 
issue for Mac OS 10.5 or newer. 

  

Is audio streaming supported in GoToMeeting? 

Yes, online audio, or VoIP, is an alternative to dialing in with a conference phone number 

  

Is video streaming supported in GoToMeeting? 

While we do not yet support streaming video, our GoToMeeting technology is fast enough to keep up with 
screen changes on the desktop, so it appears as if it is streaming video.  

Because more data is being sent to all meeting attendees, bandwidth usage will go up for all meeting 
participants. The amount will depend on the resolution and length of the video. 

Also, certain versions of Windows Media Player with Microsoft DirectX (an advanced suite of multimedia 
application programming interfaces, or APIs, built into Microsoft Windows operating systems), will not 
display the video. 

To enable video display for your meetings, you need to disable Hardware Overlay for your player. Please 
see your media player's help section for instructions on disabling Hardware Overlay. 

  

Why am I having trouble sharing specific applications during a meeting? 

http://support.gotomeeting.com/ics/support/default.asp?deptID=5641&task=knowledge&questionID=1065�
http://www.gotomeeting.com/�
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If you are using a multi-monitor enhancement application like UltraMon™ or ObjectDock™ software that 
adds a button to each window you may experience difficulties sharing specific applications. Try disabling 
the window buttons in these types of applications to resolve the issue.  
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Audio FAQs 
What if I can't hear other callers? 

• In the Attendee List of your Control Panel, click the audio icon to unmute an individual 
attendee or click Unmute All to unmute all attendees in the meeting. 

• Telephone users: Hang up and dial back in. 
•  VoIP users: 

a. Test your speakers setup. Click Audio Setup in the Audio Pane to select the correct device. 
Mac users should: click the speaker icon in the Audio Pane to select the correct device. 

b. Check the volume setting in audio setup. Click Speakers Setup and then click Play Sound. 
Adjust the slider bar to the desired volume. 

What if other callers can't hear me? 

• You can change your audio selection from the Audio Pane if you scheduled your meeting to offer 
both VoIP and telephone options. 

• Telephone users: Hang up and dial back in. 
• VoIP users: 

a. Click Audio Setup in the Audio Pane to see if the correct microphone device is selected? 
Mac users should: click the microphone icon in the Audio Pane to select the correct device. 

b. If using a microphone, check to see if your microphone has a physical mute/unmute button 
on it? If it does, make sure your microphone is not muted. 

c. If an attendee can’t hear you, his or her speaker volume may be off or set too low. 
d. Analog microphones are sometimes too quiet; we recommend using a USB headset or USB 

desktop microphone instead. 
e. If you are using a desktop microphone, avoid touching the microphone since it may cause a 

reduction in the volume of your voice. 
f. Speaking very loudly can affect the volume; try speaking at a lower level. 
g. The speed of your Internet connection can affect one-way sound. For optimum performance 

when using VoIP, we recommend a broadband Internet connection. 
h. File sharing: Uploading a file while using GoToMeeting can sometimes affect VoIP sound 

quality. It is recommended that you close all file sharing applications before you start your 
meeting. 

i. Streaming music or video while using GoToMeeting can sometimes affect VoIP sound 
quality. It is recommended that you close all streaming music or video before you start your 
meeting. 

What if I hear static, beeping or a clicking sound? 

• Electronic devices, such as Blackberries, can affect the sound quality of microphones and 
speakers. To avoid this, keep any electronic handheld devices away from your microphone and 
speakers during your meeting. 

What if I experience an echo, feedback or background noise? 

• A USB headset is recommended (see VoIP Audio Device Recommendations). 
• If you suspect an echo is coming from an attendee, see who is speaking by looking at the bottom 

of the Audio Pane. Then mute that attendee or ask the attendee to lower his or her speaker 
volume. You can also click Mute All in the Audio Pane. 

• If you join your meeting via telephone make sure the audio setting on your Control Panel is not set 
to Use Mic & Speakers. 

• Built-in or external speakers can cause echo. We recommend reducing the speaker volume to a 
low level. 
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• Laptops with built-in microphones can pick up noise and cause echo. Using a built-in microphone 
for your audio is not recommended. If you know how to turn off your laptop’s built-in microphone, 
turn it off for your presentation. (Check your laptop’s owner manual.) 

• Webcams with microphones can pick up additional noise and cause echo. Using a Webcam for 
your audio is not recommended. 

• A meeting is best presented from a quiet location. 
• If using a microphone, move the microphone closer to your voice and away from competing 

sounds (e.g. computer fans). 
• Avoid moving or touching the microphone during your presentation. 

What if words are clipped or dropped? 

Dropped words, delays or robotic sounds are often due to poor network performance, lack of memory or 
high CPU usage. 

• Close all applications you are not using for your presentation. 
• VoIP users: A dial-up Internet connection can cause poor performance. For optimum performance 

when using VoIP, we recommend a broadband Internet connection. If the problem persists, switch 
to Telephone mode. Select Use Telephone in the Audio Pane and dial in to the meeting. 

How do I adjust my VoIP audio volume? 

• Click Audio Setup in the Audio Pane. Under Speakers Setup, move the slider bar to the desired 
volume. 

What if I get an error message? 

No Speakers Detected 

An error message will appear if speakers (or headset) are not present or are not connected properly, or if 
there is no sound card installed in your computer. You will not hear audio at this time and will not be 
heard in the conference. 

• Check that your speakers (or headset) are properly connected and click Try Again in the Audio 
Pane of the Control Panel. Please refer to the VoIP Audio Setup in this section for more 
information. 

• If you have the option to join the meeting via telephone, you will automatically be switched to 
Telephone mode. Dial in to the conference using the number and audio PIN provided in the Audio 
Pane of your Control Panel. 

 

No Sound Detected 

After the first minute of a session, GoToMeeting looks for microphone input from attendees who are using 
a microphone, have speaking rights and are unmuted. 
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If no input is detected, you may get a "Trying to speak?" error message. This error may appear under the 
following conditions: 

• You have not spoken or made any sound during the first minute of joining the meeting. 
-Or- 

• The microphone device was incorrectly selected. You can click the Audio Setup link if you are 
trying to speak but can’t be heard. Please refer to See VoIP Audio Setup in this section for more 
information. 

 

No Microphone Detected 

• An error message will appear if a microphone (or headset) is not present or is not connected 
properly. You will still be able to hear the meeting but will not be able to speak. 

• Check that your microphone is properly plugged in. If it is, test your microphone device and click 
Try Again in the Audio Pane of the Control Panel. Please refer to VoIP Audio Setup in this section. 

• If you have the option to join the meeting via telephone, you can switch to Telephone mode. Then 
dial in to the conference using the number and audio PIN provided in the Audio Pane of your 
Control Panel. 

 

Microphone Disconnected 

An error message will appear if your microphone fails or is unplugged after joining a meeting. When this 
happens, you will no longer hear audio nor be heard by others. 

• Check that your microphone is properly plugged in. If it is, test your microphone device and click 
Try Again in the Audio Pane of the Control Panel. See VoIP Audio Setup – PC or VoIP Audio 
Setup – Mac in this section. 

• If you have the option to join the meeting via telephone, you can switch to Telephone mode. Then 
dial in to the conference using the number and Audio PIN provided in the Audio pane of your 
Control Panel. 
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Virtual Operating System (VMware, Parallels, etc.) 

An error message will appear if you are attempting to join a meeting using VoIP through a virtualized 
operating system, such as VMware, Parallels, etc. In this instance, to connect to audio, please choose 
one of the following: 

• Rejoin the meeting through a non-virtual operating system. 
• If you have the option to join the meeting via telephone, you can switch to Telephone mode. Then 

dial in to the conference using the number and audio PIN provided in the Audio Pane of your 
Control Panel. 

 

How do I turn entry and exit chimes on/off? 

You must be dialed in via telephone to turn entry and exit chimes on or off. In GoToMeeting, entry and 
exit chimes are turned on by default. Press *8 to cycle through the entry and exit chimes options. 

How do I mute and unmute attendees? 

• PC users: Click the microphone or handset icon  (a), (b) 
• • Mac users: Right-click an attendee's name 
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Audio Tips and Best Practices? 

• As with any meeting, it is important to test your sound quality and audio settings before your live 
event. 

• If you plan to record your meeting, be sure to test the Recording feature prior to your meeting; start 
a Meet Now and record a few minutes to test your settings. 

• Close all applications and documents you are not using for your presentation; applications running 
in the background may use up your computer’s bandwidth and affect system performance. 

• Keep attendees muted during your presentation and unmute individual attendees as necessary. 
Attendees are joined unmuted by default. 
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Recording FAQs 
Why can't I record? 

To record a meeting, you must use a PC and have Windows Media Player 9 or above. You can download 
this for free at http://www.microsoft.com/windows/windowsmedia/default.aspx.   

   

Why does my finished recording only display a blank screen? 

To avoid a recorded meeting with a blank screen, please ensure the presenter initiates some type of 
screen action (such as advancing a presentation slide) after clicking the Start Recording button. If 
recording begins before the presenter shares his or her screen and there is no screen action then the 
finished recording will only include a blank screen and audio.  

  

Can meeting attendees record a meeting using the GoToMeeting recording feature? 

No, only PC-based meeting organizers or promoted organizers have access to the GoToMeeting 
recording feature. 

  

How do I record a meeting with audio? 

To record audio, an organizer must have a sound card installed on his or her computer. (If you can hear 
music played on your computer, you have a sound card.) If you are using GoToMeeting integrated audio, 
the audio you and your attendees transmit over the phone or VoIP (using a microphone connected to 
your computer) will be recorded automatically when you click the Start Recording button.  

If you are recording a teleconference using an audio service other than GoToMeeting integrated audio, 
you can position the microphone next to the phone or set up a phone-recording adapter to your phone 
and line-in input on your computer’s sound card. In addition, be sure that the Record Audio option is 
selected from the Recording category in your GoToMeeting Preferences.  

   

How can I improve the quality of my meeting recordings? 

The lower you set your monitor resolution, the better the quality of the meeting recording. We recommend 
a maximum resolution of 1024 x 768 for optimal recording quality. Also, it is best to view your recording in 
full-screen mode. 

  

What happens if I click the Stop button in the Recording pane in the middle of a meeting and then 
resume recording? 

The meeting recording stops when you click the Stop button in the Recording pane and resumes 
recording when you click the Start Recording button. However, a new file is not created for each recorded 
segment of the meeting; it is simply appended to the existing recording file. You will only have one 
recording file per meeting. 

  

What happens if one of the presenters on my recorded meeting has a larger screen than I do? 

http://www.microsoft.com/windows/windowsmedia/default.aspx�
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The recording will have the dimensions of the largest screen presented during the meeting. The portions 
of a recorded meeting that show a smaller screen will display the image centered in the playback window 
with a black border around it.  

  

How do I save my meeting recording? 

Recordings are automatically saved to the path indicated under the Recording category in your 
GoToMeeting Preferences when you end or leave a meeting. Impromtu meetings will be named with the 
date and time plus the words “Meet Now,” while scheduled meetings will include the meeting subject in 
the file name. Note that you cannot change the location where you would like to save a recording once 
you have clicked the Start Recording button. If you cannot find your recording, check the path listed in the 
"Save in" pane of your Recording Preferences. 

  

Where are my recorded meetings stored? 

The default destination for recorded meetings is the My Documents folder. You can change the 
destination location only before recording begins. It is recommended that the designated location have a 
minimum of 1 GB of free space to accommodate the recording.  

  

How do I play back a recorded meeting? 

First you must end the meeting that you are recording. GoToMeeting will then automatically save your file 
with the meeting name you designated at the time of scheduling as well as the date and time. Impromptu 
meetings will be named with the date and time of the meeting followed by “Meet Now.” 

1. Navigate to the directory that is listed in the Save in: field under the Recording Preferences 
category. 

2. Click the file name to start the replay.  
3. Press Alt and Enter on your keyboard at the same time to maximize the Viewer Window for best 

replay quality. 

*To view a meeting recorded in the GoToMeeting format, you must either have GoToMeeting installed, or download the 
GoToMeeting codec (GoToMeeting 2.0 decoder) at http://www.gotomeeting.com/codec.  

**To view a meeting recorded in the Windows Media format, you will have to wait until the conversion process is complete. 
GoToMeeting converts the recorded meeting into a Windows Media Player file after the meeting is over so that the impact on CPU 
resources doesn’t bog down the computer during the meeting. Allow time for the conversion to take place. The time needed is 
dependant upon video content, CPU speed and amount of memory available. 

***Playing a recorded meeting back before ending the meeting may cause abnormal playback behavior. Be sure to end the meeting 
before playing it back. 

  

When I play a recorded meeting, it plays back scrambled. Is there something I can do to fix this? 

If you experience scrambled playback of a meeting recording, which can happen if the presenter used a 
multiple-monitor setup, you can try the following: 

In Windows Media Player, go to the Tools menu and select Options. Click Advanced under the 
Performance tab. In the dialog that pops up, uncheck “use video mixing renderer.” Click OK until you 
have dismissed all dialogs. Play the video again, and it should play unscrambled. 

  

Can I edit a recorded meeting?  

http://www.gotomeeting.com/codec�
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The GoToMeeting Recording and Meeting Playback feature allows you to record and preserve meetings 
as either a GoToMeeting video file or a .WMV file. If you wish to edit either file type you may need to first 
convert the file into an editable format with a program like Windows Media Encoder. Once converted, the 
file can be edited with the software of your choice. View this short video on how to convert a file with 
Windows Media Encoder.  

  

What is the best way to distribute a recorded meeting? 

If a meeting recording is small enough, you can distribute it as an email attachment. However, most 
recorded meetings will be too large for emailing. If this is the case, you may want to upload the file to a 
Web server for easy access. Remember that Mac-based viewers can only view meetings in the Windows 
Media Player format and that PC-based viewers must have GoToMeeting or the GoToMeeting 2.0 Video 
Codec installed to watch a recorded meeting created in the GoToMeeting format. The GoToMeeting 2.0 
Video Codec is available to download for free at: http://www.gotomeeting.com/codec and can be 
distributed freely. Regardless of the format, all viewers must have Windows Media Player 9 or higher to 
view the recording. 

Citrix Presentation Server FAQs 
Organizer FAQs 

Once I start a meeting, it runs on my local desktop.  When I try to invite other attendees using the 
“By email” option on the organizer Control Panel, GoToMeeting doesn’t integrate with my 
published version of Outlook (or Lotus Notes). How can I resolve this? 

You need to verify that the option selected in your GoToMeeting Preferences under the Integrations 
category matches the option selected in the Advanced section of the Integrations.  

Attendee FAQs 

When I am designated the presenter at a meeting, I can only show the applications that are 
published to me from Presentation Server and nothing that is on my local desktop. How can I 
present my local desktop? 

Contact your Citrix Presentation Server Aadministrator about installing GoToMeeting on Presentation 
Server. By installing GoToMeeting and configuring the recommended settings on Presentation Server, all 
GoToMeeting sessions will be redirected to the desktop. Running a meeting on the local desktop enables 
you to present anything on your desktop. 

http://www.microsoft.com/downloads/details.aspx?FamilyID=5691ba02-e496-465a-bba9-b2f1182cdf24�
http://goview.com/?id=9589e8f4-6c59-4506-8a9e-9f2703374714�
http://goview.com/?id=9589e8f4-6c59-4506-8a9e-9f2703374714�
http://www.gotomeeting.com/codec�
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Desktop Notifications 
What is the Desktop Notifications feature? 

Desktop Notifications is a free GoToMeeting feature designed to deliver simple and effortless access to 
complimentary Citrix Online software upgrades, information, news and discounts individual users may be 
eligible for. Desktop Notifications delivers information right to your desktop, allowing you to safely receive 
important product information that is relevant to you. Desktop Notifications are sent only by Citrix Online 
as a service to our customers.  

  

How does it work? 

Occasionally, when you are connected to the Internet, Desktop Notifications will automatically connect 
with Citrix Online servers to see if there are any new messages for you. If there are any messages for 
you, Desktop Notifications will display them on your computer screen. 



GoToMeeting® User Guide

© 2010 Citrix Online, LLC. All rights reserved. 104

Connection Help 

  

Connection Test Help 
Most connection-test difficulties are related to user-authentication issues. Please answer the question 
below to assist you with determining if this problem exists and which actions to take. 

Did you see an Authentication Required dialog box containing three fields labeled Domain, User Name 
and Password? 

• Yes, I did see the dialog box and I believe I entered all the correct information but I am still having 
trouble. 

• Yes, I did see the dialog box but the ‘Domain’ field was empty or may be incorrect. 
• Yes,  I did see the dialog box but the 'Domain' field was absent. 
• No, I did not see the dialog box. 
• Help, I followed the steps but I am still having trouble. 

  

Yes, I did see the dialog box and I believe I entered all the correct information but I am still having 
trouble. 

The user name and password required here are the same as those that you use to log on to your 
Windows computer.  

As when entering all user names and passwords, please make sure that: 

• You are typing correctly, especially since you cannot see the password characters as you type 
them. 

• Your Caps Lock key is off. 
• You do not have any trailing white-space characters in the fields. Check this by deleting and 

retyping the entire contents of each field or by checking the end of each field for a blank space. 

  

Yes, I did see the dialog box but the Domain field was empty or may be incorrect. 

Our software will attempt to fill in the Domain field for you. In rare cases this may not work, and the 
Domain field will be blank or an incorrect Domain will be shown. 

You can easily determine and verify your correct Domain for the Domain field. For instructions, click the 
link for your operating system: 

• Windows 2000 
• Windows XP 

  

Yes, I did see the dialog box but the Domain field was missing. 

This dialog box indicates that ‘Basic Authentication’ is in use on your Web proxy. The User Name and the 
Password required here might be the same as those you use to log on to your Windows computer.  

However, your Web proxy may require different passwords than those you use to log on to your Windows 
computer. Your network administrator can confirm whether or not you have the correct information.  

As when entering all user names and passwords, please make sure that: 
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• You are typing correctly, especially since you cannot see the password characters as you type 
them. 

• Your Caps Lock key is off. 
• You do not have any trailing white-space characters in the fields. Check this by deleting and 

retyping the entire contents of each field, or by checking the end of each field for a blank space. 

  

No, I did not see the dialog box. 

Please contact Global Customer Support. 

  

Help, I followed the steps but I am still having trouble. 

Please contact Global Customer Support. 

  

Using GoToMeeting/GoToWebinar with Firewalls  

 Using GoToMeeting/GoToWebinar with personal firewalls 

If you can't connect and have a personal firewall (ZoneAlarm®, Norton Personal Firewall™, etc.) installed, 
make sure that GoToMeeting/GoToWebinar is not being blocked. If so, unblock 
GoToMeeting/GoToWebinar and try again. 
 
Additionally, you can configure your personal firewall to enable GoToMeeting/GoToWebinar to access the 
Internet anytime you need it to. 

 Enabling GoToMeeting/GoToWebinar to access the Internet 

The first time you run GoToMeeting/GoToWebinar on a PC that has a firewall installed, you will set 
off the firewall and be prompted to allow GoToMeeting/GoToWebinar to access the Internet. 

1. Select the check box to Remember the answer each time I use this program. 
2. Click Yes to enable GoToMeeting/GoToWebinar to access the Internet. 

 Using GoToMeeting/GoToWebinar within a corporate Environment 

If you do not have a personal firewall but are in a corporate environment, you may have a hardware 
firewall. Please provide the document found at www.citrixonline.com/iprange to your IT department so 
that they may allow GoToMeeting/GoToWebinar to connect. 

If a connection still cannot be established, please contact Global Customer Support. 

http://support.gotomeeting.com/ics/support/default.asp?deptID=5641&task=knowledge&questionID=4412�
http://support.gotomeeting.com/ics/support/default.asp?deptID=5641&task=knowledge&questionID=4412�
http://www.citrixonline.com/iprange�
http://support.gotomeeting.com/ics/support/default.asp?deptID=5641&task=knowledge&questionID=4412�
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Using GoToMeeting with a Firewall 
If you are experiencing issues when connecting to your meeting it may be due to an Internet Security 
application such as a Firewall. Please ensure the following files have full access to the Internet: 

 GoToMeeting Components 
g2m_download.exe G2MStart.exe  G2MChat.exe  
AppCore.exe G2MLauncher.exe G2MQandA.exe 
G2MInstallerExtractor.exe G2MTesting.exe  G2MSessionControl.exe 
G2MCoreInstExtractor.exe G2MMaterials.exe G2MMatchMaking.exe 
G2MCodecInstExtractor.exe G2MPolling.exe G2MRecorder.exe  
G2MInstHigh.exe G2MView.exe G2MTranscoder.exe  
G2MInstaller.exe G2MUI.exe G2MTranscoder.exe  
G2MUninstall.exe G2MFeedback.exe G2MTranscoder.exe  
G2MComm.exe G2MHost.exe G2MTranscoder.exe  

These GoToMeeting components need to be admitted through three ports: 80, 443 and 8200. One-way 
TCP connectivity is needed (TCP outbound). Should you need to authorize specific IP ranges, our IP 
ranges can be found here: www.gotoassist.com/iprange. 

  

Using GoToMeeting with a Firewall 

Setting up a firewall to enable GoToMeeting to work requires that you take a little extra time to configure 
your software to allow GoToMeeting to run without interruption. Setting up GoToMeeting to work with a 
firewall involves two steps. 

 To set up a firewall to allow GoToMeeting 

Step One: Enable GoToMeeting to access the Internet 

The first time you host a GoToMeeting from a firewall protected PC, you will set off the firewall and 
be prompted to allow GoToMeeting to access the Internet.  

1. Select the check box to "Remember the answer each time I use this program." 
2. Click Yes to enable GoToMeeting to access the Internet.  

  

Step Two: Configure your firewall to accept all GoToMeeting files 

1. Open your firewall console and manually select the option to allow each of the above 
components. After doing this once, you should not need to repeat this process again. 

Using GoToMeeting with Norton Internet Security Firewall 

 To set up a Norton firewall to allow GoToMeeting 

1. Right-click on the Norton Internet Security  icon on your host computer’s system tray (bottom-
right of your desktop).  

2. Select Open Norton Internet Security from the system tray menu. 
3. Select Personal Firewall from the Status & Settings menu and click the Confiure button. 
4. Select the Programs tab, locate GoToMeeting and then click Add. 
5. To begin adding files, click on g2mcomm.exe and click Open. 
6. From the Program Control prompt select Permit from the drop down menu and click OK. 

http://www.gotoassist.com/iprange�
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7. Repeat these two steps to add the remaining GoToMeeting files:  

  

Using GoToMeeting with Norton Transaction Protection 

If your version of Norton Internet Security has the Norton Transaction Protection feature enabled, you 
may need to adjust your Norton settings in order to use GoToMeeting. 

 To set Norton Transaction Protection to allow GoToMeeting to run 

1. If you have not already done so, host a practice meeting. 
2. End the session. 
3. While physically present, right-click on the Norton Internet Security  icon on your system 

tray. 
4. Select Open Norton Internet Security from the system tray menu. 
5. Click on the Norton Internet Security tab at the top of the Norton window. 
6. From the Settings drop-down list, click the Norton Internet Security Options link. 
7. Click the Transaction Protection link from the left side of the window. 
8. Change the status to allow g2mlauncher.exe and then click OK. 

  

Using GoToMeeting with ZoneAlarm Firewall 

 To set up a ZoneAlarm firewall to allow GoToMeeting 

1. Double-click the ZoneAlarm  icon on your host computer’s system tray.  
2. Select Program Control from the menu on the left.  
3. Verify that you are viewing the Programs tab. 
4. Click the Add button on the bottom-right of the screen.  
5. Navigate to the GoToMeeting folder on your computer (C:\Program Files\Citrix\GoToMeeting). 
6. Highlight all of the GoToMeeting files in that folder and click Open to add the GoToMeeting files. 
7. Locate the GoToMeeting file in the Programs list, click the icon in the Trust Level column and 

select Super. Repeat this step for each of the GoToMeeting files. 
8. Finally, click each  icon in the Access and Server columns that correspond to a GoToMeeting 

program and select Allow. 

. 
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Network Authentication 
If you are having trouble completing your network authentication, please select your operating system for 
assistance. 

Windows 2000 

 To find your domain in Windows 2000 

1. Right-click the My Computer icon on your desktop and select Properties. 
2. Select the Network Identification tab. 
3. The information shown for Domain: is the name of the Windows domain to which your computer 

belongs on your company network. 
4. Please note your domain name so that you can enter it into the domain field of the Authentication 

Required dialog box. 

  

Windows XP 

 To find your domain in Windows XP 

1. Click the Start button. 
2. Right-click the My Computer icon and select Properties. 
3. Select the Computer Name tab. 
4. The information shown for Domain: is the name of the Windows domain to which your computer 

belongs on your company network. 
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5. Please note your domain name so that you can enter it into the domain field of the Authentication 
Required dialog box. 
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Contact Support 
If you are experiencing problems with GoToMeeting or have questions, please contact Global Customer 
Support. 

  

http://support.gotomeeting.com/ics/support/default.asp?deptID=5641&task=knowledge&questionID=4412�
http://support.gotomeeting.com/ics/support/default.asp?deptID=5641&task=knowledge&questionID=4412�
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